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CACANi’s Animation Workflow

Step 1 Sketch out key
frames in CACANi.

Step 2 Clean up key
frames.

Step 3 Generate In-between Frames.

Step 4 Paint 1 Frame as Color. Reference.

Step 5 Batch Paint Animation Frames.
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CACANi is a revolutionary application developed with hand drawn animators
in mind. With our proprietary tools and workflow, CACANi helps reduce the work
required by generating in-between frames based on the key frames and automatically
painting the frames, creating a smooth and realistic animation sequences in a fraction
of the time.

Features of CACANi
•

Unique Pressure Sensitive Sketching and Tracing Capabilities

With the use of graphic tablets or tablet displays, animators can choose to create their
drawings with clean, uniform lines, or organic, pressure-sensitive strokes, directly in
the software.
•

Color Separation Line Layers

To add more depth to the drawings, Color Separation Lines can be drawn to create
highlight or shaded regions. These special layers can then be hidden so that the final
painted drawings do not show the separation lines.
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•

Automatic Generation of In-between Frames

Animators can make use of CACANi’s unique animation engine to automatically
generate in-between frames after the key frames are drawn.
•

In-between Timing Adjustments

Mimicking the hand drawn animation workflow, in-between timing can be easily
adjusted via the Timing Panel.
•

Automatic Coloring of Animation Frames

Using a single painted frame as reference, painters can auto-color all the frames of an
animation sequence.
•

Unique Digital Workflow for Hand Drawn Animation

We have developed an alternative digital production pipeline to make full use of the
many advantages of CACANi. It will improve or eliminate several tedious processes
that are traditionally required in the hand drawn animation industry.
•

High Quality, Scalable Vector Output

CACANi is able to export animation sequence of any size and quality. Because all
graphics are vector-based, CACANi gives artists the freedom to distribute their
creations on multiple platforms with ease, from large HDTVs to mobile devices.
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New Features in CACANi 2.0
Since version 1, we have learnt a lot about what makes CACANi useful to animators.
With that knowledge, a lot of work has been done to increase performance and
improve the different tools that you use.

Performance Improvements
Many of the underlying functions relating to the handling of strokes and regions
have been rewritten. As a result, CACANi’s ability to handle complex drawings (More
than 1000 strokes per frame) have been sped up, while memory usage has
decreased.

Drawing like Pencil and Paper
The new Raster Layers allow you to draw and edit drawings in a traditional pixelbased manner. Color Separation Sublayers also help you to draw highlight and
shadow regions without affecting your main line art.

Better Animation Generation, Stroke Matching
Using Re-match Stroke Order, you can now make corrections to fix stroke matching
problems between keyframes. You can also now combine strokes together with the
Join Strokes option.
With the Auto Feature Points mode, you can automatically assign feature points to
the ends and sharp corners of each stroke after drawing it. This can improve the
inbetweening result. You can also overlap the feature points’ motion paths, allowing
you to create inbetweening motion that looks more natural.

Occlusion and Segment Hiding
The new Boundary Stroke and Occluded Stroke options allow you to spend even
less time in tweaking your drawings. Designate a stroke as a Boundary Stroke to hide
or reveal stroke segments automatically, all without having to grapple with layers.
Also, other than masks, the new Create Clipping Mask option will allow you to hide
strokes outside of a region.

Speeding Up Gap Closing
You can now perform gap closing using different methods, including painting regions
and closing gaps at the same time.
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In addition, you can now use the Add Points When Clinging option when drawing, or
the Add Stroke Connection Points option after drawing, to help you scale and rotate
strokes without creating more gaps.

Adaptive Stroke Width Adjustments
Thinning and thickening the stroke width of your drawings, when you’re drawing
them and after you’ve drawn them, are both now much easier with the Stroke Taper
Panel and Change Stroke Width option. Stroke widths will also adjust themselves
automatically when edited.

Editing across Multiple Cels and Frames
You can now use selected functions across multiple frames or cels. You can also use
the Select All Frames option from the context menu or configure it with a shortcut
key.
Tools and functions that support multiple cel or frame editing include the Selection
Tool and the Apply Stroke Tapering, Change Stroke Width, Randomize Strokes,
Transfer / Replace Grouping Info, Transfer Boundary Stroke Settings and the
various frames editing and frame type conversion options.

New Layers and Layer Conversion Options
On top of Raster Layers, you can now load, view and edit video frames with Video
Layers. You can also speed up layer adjustments with the Start Cel and End Cel
options. Audio layers are now like regular cels and are movable as well.
Using Rasterize Image Layer, you can now turn video frames and external images
into CACANi raster layers for further editing. You can also turn raster line art into
CACANi vector strokes with the Extract Line Art and Vectorize Layer options.

New Frame Types and Frame Type Conversions
You can now use Repeat Frames to display a frame again anywhere in the Cel Bank
without increasing memory use. You now also have a lot more flexibility in
converting between the different types of frames. Finally, much care has also been
taken to ensure that after your conversions, the timings in the Timing Panel are not
affected.

Switch Quickly between Onionskin Frames
After assigning Offpeg frames, you can toggle between displaying your active frame
and the offpeg frames quickly using shortcut keys.
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Load and Save Color Palettes
Color Palettes can now be saved as .csf files and transferred between files.

Canvas, Camera and Export Settings
You can now configure the Print Size as well as the DPI. The Animation Information
window allows you to include details about your animation in the drawings.

Export to After Effects
You can now export the layers as individual images, as well as export the layer
information to Adobe After Effects.

Better User Interface, Tool Panels, Shortcut Customization
The menus and interface have been improved and reorganized so that you can
select more options, but not increase the onscreen clutter. The Timing, Onionskin
(previously Lightbox), Navigator and Cel Bank Panels have seen more drastic
changes in the functions and user interface, while the other panels have smaller
cosmetic changes.
The Customize Shortcut window has been reorganized for greater clarity when
assigning shortcut keys. An additional section to configure the digital stylus buttons
has also been added.
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The CACANi Animation Pipeline

Import

Rough out in CACANi
(Sketch Layer)

Load External Images
(Image layer)

Animation Sequence Evaluation
Draw
Trace Key Frames (Stroke Matching / Manual Drawing)

Generate In-between Frames (Timing)
In-between
In-between Frames Adjustments (Bone Tool, Feature
Point Tool)

Segment Hiding
Clean Up
Gaps Clean up (Key Frames)

Paint Reference Color Frame

Color

Auto-Color Sequence

Colored Regions Clean Up / Manual Coloring

Export

Export Image Sequence / Video

Complete
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User Manual Icon Guide
Throughout the user manual, you will encounter some icons describing specific
interactions that you’ll need to perform with either the mouse or the digital stylus.
They are listed as below:

Left Click
Press Left Mouse Button once (Mouse) or Tap Pen Tip on screen once (Stylus)

Double Click
Press Left Mouse Button Twice / Double Click (Mouse) or Tap Pen Tip on screen Twice
(Stylus)

Left Click + Drag
Press and Hold Down Left Mouse Button and Move in Indicated Direction (Mouse) or
Press and Hold Down Pen Tip on screen and Move in Indicated Direction (Stylus)

Right Click
Press Right Mouse Button once (Mouse) or Press Pen Button once (Stylus)

Setting Up CACANi
System Requirements
Minimum Configuration
2 GHz Intel® / AMD® processor
Microsoft Windows 7
512 MB RAM
Video card supporting OpenGL 3.0 with at least 128 MB of RAM
Monitor with at least 1024x768 resolution
Mouse device
Recommended Configuration
3 GHz Intel® / AMD® processor
Microsoft Windows 7 / 8 / 10
At least 4 GB RAM
Video card supporting OpenGL 3.0 with at least 1 GB of RAM
Monitor with at least 1440x900 resolution
Graphics Tablet or Tablet Monitor device
Internet Connection will also be required for activation of software.
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CACANi makes use of advanced rendering technologies to calculate and
display the animation drawings. As a result, a relatively modern graphics card
is needed to allow CACANi to run properly.

Installation of CACANi
When installing CACANi, you will need to first download the installer file from
CACANi’s website (www.cacani.sg). The download links are sent to your email when
you purchased the software.

Alternatively, you can download the latest version of the installer from our website.
Please note that this is only for users who have purchased CACANi before. You will
need to provide the email you used during the previous purchase. For users
interested in testing CACANi, please download the trial version.
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Double Click on the file to start the installation process. Follow the
instructions given.

Activation of CACANi software
After installation, you can start CACANi by Double Clicking on the desktop
icon. Alternatively, you can open the program from the Windows Start menu.
When first starting CACANi, you will see a window asking you to enter the
product key.

If you have purchased CACANi already, you should have received an email
with the product key. If you haven’t purchase CACANi, or your license has
expired, you will need to obtain another product key by purchasing it from
the website.
You will need to copy the product key from the email and paste it into the
activation window. Internet access is required for the activation to work.
Click Activate to continue.
When activation is successful, you should see the following window.
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License Details
You can check your license information from the CACANi Help menu, under
the Subscription option.

In the Subscription window, you will see the type of license, number of days
left (for time-based subscription licenses), and number of days for offline
access for your CACANi software.

In addition, you can extend the duration of your subscription when it expires
or deactivate your license if you need to use CACANi on another computer.

Offline Usage of CACANi
CACANi requires periodic internet access for license verification.
For time-based subscription licenses, CACANi will only require
internet access every 7 days.
For perpetual licenses, CACANi will only require internet access every
30 days.
When your machine is not connected to the internet, you can track how long
your machine has been offline via the Subscription Window. You can find it in
Help > Subscription.
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Using CACANi on Multiple Computers
A single CACANi license can be transferred and used on different computers.
However, before the license can be transferred, you need to first deactivate
your license on the original computer. The CACANi license can only be used
on one computer at any given time.

Deactivation from within CACANi Software
Open the Subscription option in the Help menu.

Through the Subscription option, you will need to choose the Deactivate
License button. This will remove the CACANi license from your current
computer and allow you to transfer it to another computer.

Web Deactivation (Single License)
If you are experiencing computer issues, for example software or hardware
crashes, and cannot open the CACANi software, you can still deactivate
CACANi via our website, https://cacani.sg/deactivate-license/ .
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After submitting your license details, an email with a deactivation key will be
sent. Please enter the attached key in the second page.

Your license will be deactivated and you can use it on another computer.
IMPORTANT!
After using web deactivation, you will not be able to use this method of
deactivation for 3 days. This is because it is only for emergency situations
where there’s hardware failure.

Web Deactivation (Teams License)
If you are a Teams License administrator, you can use the same method of
web deactivation. But after submitting your license details, the page will look
different.

You can remove CACANi from any of the listed computers by clicking on the
Deactivate button. Unlike the single license version, the deactivation is
instant. There is no deactivation key needed.

01 02 03 04 05 06 07 08 09 10 11
The Menu Bar

| CACANi

Extension of CACANi Subscription
If you have a subscription or time-based license and the subscription period
has not expired yet, you can extend your usage of CACANi by purchasing a
new product key from the CACANi website.
After you purchased a new key, open the Subscription option in the Help
menu.

Choose the Extend Subscription option.

Enter your newly purchased product key into the Subscription Extension textbox.

The remaining days will be carried over into the new subscription. Your old
product key will then become invalid.
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Upgrading the CACANi License
IMPORTANT!
Before you perform an upgrade, please take note:
1. Check whether you have a subscription (time-based) or perpetual license.
2. You will need to deactivate the product key you want to upgrade.
3. After a successful upgrade, you will not be able to use the older release
any longer.

Subscription or Time-based License Upgrade
If you have a subscription or time-based license and the subscription period
has not expired, you can upgrade to all minor and major releases of CACANi
for free.
To upgrade, download and install the new release from
https://cacani.sg/cacani-download/ .
Open CACANi and choose the Upgrade option.

For subscription or time-based license upgrades, you only need to enter your
working product key. Remember to deactivate the older version of CACANi
from your previous machine.

The product key will be upgraded and activated on your current machine. The
new version is ready for use. The key will not be usable on the older version.
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Perpetual License Upgrade
If you have a perpetual CACANi license, you can upgrade to minor releases
(1.0 > 1.1 etc) for free. For major releases (1.1 > 2.0), you can upgrade your
existing license for a fee. Purchase an Upgrade Key from the CACANi website,
https://cacani.sg/store/.

The upgrade key and the download link for the new release will be sent to
your registered email address. Alternatively, you can download and install
the new release from https://cacani.sg/cacani-download/ .
Open CACANi and choose the Upgrade option.

In the Upgrade Mode section, choose Upgrade CACANi 1.x Perpetual Key
with an Upgrade Key. Enter both your existing product key and the new
upgrade key in the text-boxes. Remember to deactivate the older version of
CACANi from your previous machine.

The product key will be upgraded and activated on your current machine. The
new version is ready for use. The key will not be usable on the older version.
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Understanding CACANi’s Interface
Cel-1
The Menu Bar is where you can
find all the functions available in
CACANi.
The Property Bar lists the
properties of the various
tools in the Tool Panel.

This is where you can find additional
controls for creating cels, frames and
also playback your animation
sequences in CACANi.

This is where you can find various
controls for changing the display
and behavior of tools and
panels in CACANi.

The docking areas at the
bottom and sides of CACANi
are where you can place your
panels so that they do not
obstruct your canvas.
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Interface Overview - Full
Panel Access

Cel Selection Bar
Tool Panel
Menu

Display Property Bar
Canvas Display
Stroke Display
Region Display
Onion Skin Display

Property Bar

Drawing Controls
Onion Skin Panel
Layer Selection Bar
Navigator

Canvas
Stroke Taper Panel

Layer Panel

Cel Bank
Cel View
Frame View
Frame Controls

Timing Panel
Auto Color Panel
Playback
Controls

Color Panel
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Interface Management
Panel Access Bar
In CACANi, the various tools for animation are placed in Panels, and these are
displayed (or hidden) via the Panel Access Bar, located at the top right corner of the
workspace.

Tool Panel
Stroke Taper Panel
Navigator
Color Panel
Auto Color Panel
Cel Bank
Layer Panel
Timing Panel
Onion Skin

Panel Docking
Based on user preferences, Panels can be arranged to be either free-floating or
attached/docked to the sides of the workspace.
*Note that the Cel Bank is the exception: it can only be docked to the bottom.

To dock a free-floating panel, Drag it to the left, right, or bottom side of the
workspace. The panel will snap into the enlarged dock area.
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A panel can also be docked in between other panels, or docked behind another
panel.

When multiple panels are docked horizontally, Left Click and Drag the empty dock
area to move them together.

Panels can be minimized by Double Clicking on the panel tabs.
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To close the panels, hover to the rightmost corner and Left Click on the ‘X’ icon.

The docking area can be minimized by Left Clicking on the docking arrows.

When there are too many docked panels, use the dock slider to navigate to the
hidden panels.
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Canvas Navigation
There are several manners in which the canvas can be manipulated to change its
view; one can move the canvas vertically or horizontally, rotate the canvas, zoom in
or out and flip the canvas horizontally or vertically.

Move around the Canvas
1. Select Pan Tool from the Tools Panel. On the canvas, Tap and Drag the stylus.
2. Press and Hold Space. Then on the canvas, Tap and Drag the stylus to pan.
3. Enable the Navigator from the Panel Access Bar. Hold and Drag the stylus in the
preview window.

Thumbnail view of canvas

Shows the Matching Frame

Magnification of Canvas
1. Select the Zoom Tool from the Tools Panel. To zoom in, place the stylus on the
canvas and Drag to the Right. Drag the stylus to the Left to zoom out.
2. Press and Hold Ctrl + Space. On the canvas, Hold and Drag the stylus Left to Zoom
Out of the canvas, and Drag Right to Zoom In to the canvas.
3. Press 1 to Zoom Out of the canvas, press 2 to Zoom In to the canvas.
4. Enable the Navigator from the Panel Access Bar. Use the Zoom Tool or type the
zoom level in the input field.
Zoom Level
Tap on icon for zoom level
presets. Tap on number for
manual zoom level input.
Input values from 1.6% to
6400%

In Matching Frame mode
only
While Holding Ctrl + Space,
Hold and Drag stylus Right
to zoom into the canvas,
Drag Left to zoom out of
the canvas
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Canvas Rotation
1. Select Rotate Tool from the Tools Panel. Drag with the stylus on the canvas to rotate
the canvas around the center point of the drawing workspace.
2. Press and Hold Shift + Space. On the canvas, Hold and Drag the stylus either Clockwise
or Anti-Clockwise to rotate the canvas accordingly.
3. Press 3 to rotate the canvas anti-clockwise, press 4 to rotate the canvas clockwise.
4. Enable the Navigator from the Panel Access Bar. Use the Rotate Tool or type the
rotation angle in the input field.
In Matching Frame mode only
Tap and Drag Right to rotate the
canvas clockwise, Drag Left to
rotate anti-clockwise

Rotation Angle
Tap on number to perform manual
rotation input.
Input values from -180° to 180°

User Manual

Layer Panel
Add Layer
Add Image Layer
Add Sketch Layer
Duplicate Layer
Add Color Separation Layer (Blue)
Add Color Separation Layer (Red)
Add Color Separation Layer (Green)
Add Color Separation Layer (Custom)
Delete Selected Layer

Lock Selected Layer

Layer Opacity Slider
Layer Opacity Input

Layer Name
Layer Color Tag
Layer Onionskin Property
Layer Lock Property
Layer Visibility Property

The Layer Panel provides another means of layer manipulation other than the Cel
Bank.
To select a layer for drawing, simply Tap / Left Click once on any layer. Stroke Colors
are changed via the Color Panel.
For the Color Separation Layers, stroke colors are determined by the Color Separation
Colors.
*Note that it is not possible to draw on the Image Layer without first converting it.
Please refer to Chapter 07 – Rasterize Image Layer.
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Layer Panel Operations
To add a layer, simply press any of the Add Layer buttons in the Layer Panel.

The order of the layers added are shown visually in the Layers Panel; strokes and filled
regions in the topmost layer will hide strokes and filled regions in lower layers.

To remove a layer, press the Delete Layer button after selecting the desired layer.

While Holding Shift, Left Click on the first and last layer to select a range of layers.
Alternatively, Hold Ctrl to select multiple layers in any order.

Selected
Layer

Hold Shift to select
layers in sequence
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Selected
Layer

Hold Down Ctrl to
select layers in
any order

You can also change the order of a layer by selecting the layer. First, select the desired
layer, then Left Click and Drag the layer to the desired position. It is also possible to
select multiple layers in the same manner as mentioned above.
Each layer has 4 properties: Layer Tag, Layer Visibility, Layer Lock and Layer Onion Skin.

Layer Tag

Allows you to assign the layer with a specific color for easier identification and
selection.
Layer Visibility
Controls whether the contents in that layer will be shown on the canvas.
Layer Lock
Determines whether the contents in that layer can be modified.
Layer Onion Skin
Determines whether the contents in the layer will be displayed as onion-skinned
images.
Left Click on the icons to enable or disable the respective properties.
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Change Drawing Layer Color
The Drawing Layers colors can be altered by Double Clicking on the Drawing Layer
Color button in the panel.

A Color picker dialog will appear to allow you to choose the color. Click OK to confirm
your selection or Cancel to preserve the previous color.

Color Separation Layers
Used for strokes that define highlight and shadow regions on the canvas. These layers
are added by Left Clicking on the Add Color Separation Layer Buttons.
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Customising Shortcuts
From the menu bar, select File > Customise Shortcuts.
A dialog box will appear showing the category and commands with shortcuts in
CACANi.
3

4

1
2
5
6

7

8

9

1

Functions and Commands Tabs
Lists of all user assignable functions and commands in CACANi, organized in tabs.

2

Menu Functions / Commands Selection
Allows you to choose the menu function or command you want to assign a
shortcut for.

3

Currently Assigned Shortcut
Shows you the shortcut that is currently assigned to the function or command.

4

New Shortcut Assignment
Allows you to enter a shortcut for the selected function or command.

5

Assign Shortcut Button
Once a shortcut is entered, you can click this button to confirm the shortcut
assignment.

6

Clear Shortcut Button
Allows you to remove a currently assigned shortcut to the selected function or
command.

7

Import and Export Shortcuts Buttons
Allows you to load or save user assigned shortcuts via CACANi shortcut (.csc) files.
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8

Reset All Shortcuts Button
Allows you to remove all user assigned shortcuts and revert to the original state.

9

Confirmation Buttons
Allows you to confirm changes and exit the dialog box by clicking Ok or remove
changes by clicking Cancel.

Assigning Shortcuts
First, a list of the tabs in the shortcuts dialog:

Menu Commands Shortcuts

Tool Commands Toggle Shortcuts

Tool Commands Hold Shortcuts

Tool Panels Display Shortcuts

Other Commands Shortcuts

Pen Shortcuts

User Manual
Procedure for Assigning Shortcuts
You can assign shortcuts easily by going into the File Menu, then choosing Customise
Shortcuts. In this example, we are going to change the toggle shortcut for the
Selection tool. Currently, Q is assigned to the tool.

When the shortcut [W] is entered into the New Shortcut field, CACANi warns that the
shortcut has already been assigned to another tool, the Stroke Editor.

Ignoring the first warning and clicking the Assign Shortcut button will bring up another
warning.

Finally, clicking the OK button will make CACANi change the shortcut to W, and
remove the original shortcut assignment. Note that the Stroke Editor does not have
any shortcut assigned to it now.
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Toggle and Hold Shortcuts
Other than the typical keyboard shortcut assignments, CACANi also has a unique
system of shortcuts that allows you to toggle tools instead of switching to them.

In the Tools (Toggle) and Tools (Hold) tabs, the tools listed are mostly similar. This is
because for those commands, you can choose to either configure a toggle shortcut
for it, or a hold shortcut.
For example, the keyboard shortcut Q is assigned to the Selection tool.
A Toggle shortcut is where, after you Press and Release Q, the active tool will change
and remain as the Selection tool until you choose another tool to switch to.
A Hold shortcut is where the active tool changes and remains as the Selection tool as
long as Q is held down. The moment you release Q, the active tool reverts to your
previous tool.
This is useful for artists who tend to use only a few tools but need to switch to other
tools occasionally.

Additional Options in Tools (Hold)
In the Tools (Hold) tab, there are additional options not configurable in the Tools
(Toggle) tab.
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CACANi Menu Options

The Menu Bar holds various menus that allow you to control or change various
features in CACANi.

File Menu

New [Ctrl + N]
Creates a new file. If a file is currently being worked on, a dialog will prompt whether
to save the current work.

Open [Ctrl + O]
Opens a previously saved CACANi (.cacs) or Scalable Vector Graphics (.svg) file.

Animation Information…
Allows you to input Scene or Cut Number, Description and Duration of the current file.
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Canvas Size…
Allows you to edit or reset the resolution and color of the viewable canvas.
Please see Chapter 04 – Changing Canvas Settings.

(1.x) Merge File
Integrated into the Import CACS, SVG File option.

Save [Ctrl + S]
Saves the current work. If the current work was not saved before, a dialog will prompt
on the name and the type of file to save to.

Save as… [Ctrl + Shift + S]
Saves the current work as a different file. A dialog will prompt for the name and the
type of file to save to.
Please see Chapter 10 - Saving the Animation.

Save as Project… [Ctrl + Shift + P]
Saves the current work and linked image / audio / video files into a folder.
Please see Chapter 10 - Saving the Animation.

Enable File Autosaving
When enabled, CACANi will automatically make a backup of the currently opened file
at specific intervals. It is enabled by default.

Autosave Settings…
Allows you to change the folder where the autosave files are stored. Allows you to
adjust the elapsed time before CACANi automatically makes a copy of your current
file. To prevent the autosaving from interrupting your drawing, you can also configure
the function to wait until you stop drawing.

User Manual
Import
Image…
Creates a new Image layer and displays your selected external images in the canvas.
Multiple images can be selected. Compatible image formats include BMP, JPG, JPEG,
PNG, TIF, TIFF, TGA and TARGA.
Image Sequence…
Creates a new Image layer and displays a series of images in the canvas. Only image
sequences in numeric order, for example, image01, image02 and so forth, are
supported. You only need to select the first image in the sequence. Compatible image
formats include BMP, JPG, JPEG, PNG, TIF, TIFF, TGA and TARGA.
Video…
Allows you to select a video file, then a new Video layer is created and the frames of
the video are displayed in the canvas. Compatible video formats include AVI, MKV,
MP4, MOV and WMV.
CACS, SVG File…
Brings the contents of a different file into the current file. Supports CACANi (.cacs) or
Scalable Vector Graphics (.svg) files. Imported Cels are placed above the cels in the
current file.

Export Image
Exports the drawings as images. A dialog will prompt you for the format, name,
resolution and other settings of the images. Exportable image formats include BMP,
JPG, PNG, TIF, TGA, GIF and SVG.

Export Video
Exports the drawings as a video. Exportable video formats include AVI, MP4 and WMV.

Export to After Effects®
Exports the drawings, cels, layers and timing as a collection of images and an After
Effects script.
Please see Chapter 10 – Exporting the Animation.

Recent Files List
Records the last 10 files that were in use for easier access.

Customise Shortcuts…
Brings up the Shortcuts Customisation Panel.
Please see Chapter 02 - Customising Shortcuts.

Shortcuts Guide
Shows an overview of the default shortcut keys.
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Enable Windows Ink (Tablet PC) Support
Turns on support for Windows Ink pen devices, allows CACANi to obtain pressure
information. It is disabled by default.

Switch to Bright Interface / Switch to Dark Interface
Changes the user interface of CACANi to a brighter or darker theme.

Exit
Closes the CACANi software. If the existing work has not been saved, an ‘Unsaved
Changes’ dialog box will appear.

User Manual

Edit Menu

Undo [Ctrl + Z]
Cancels the previous action. You can undo up to a maximum of 50 actions (30 actions
in 1.x).

Redo [Ctrl + Y]
Repeats the previous action. You can redo up to a maximum of 50 actions (30 actions
in 1.x).

Clear Undo/Redo History
Deletes the undo/redo information, as a way to reduce memory consumption.

Copy [Ctrl + C]
Duplicates and stores the selected strokes in the clipboard.

Cut [Ctrl + X]
Remove the selected strokes from the canvas and place them in the clipboard.

Paste [Ctrl + V]
Transfers the stored strokes back onto the canvas in the active sheet.

Clone (Ignore Stroke Index) [Shift + V]
Transfers the stored strokes back onto the canvas in the active sheet, disregarding any
stroke indices. Formerly named Single Paste in CACANi 1.x.

Paste from Navigator
Copies selected strokes in the Navigator (Matching Frame mode only) and paste them
onto the canvas in the active sheet.

Delete [Del]
Removes the selected strokes from the canvas.
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Smart Paste Selected Strokes
Unmatched strokes selected in the Navigator (Matching Frame mode enabled) are
pasted into the active frame.

Smart Paste All Strokes
All unmatched strokes in the reference key frame are pasted into the active frame.

Move Selected Element(s) Up/Down/Left/Right 1 Pixel
Moved to Objects menu.

Move Selected Element(s) Up/Down/Left/Right 10 Pixels
Moved to Objects menu.

Select All Frames
Makes a selection of all the frames in the Cel Bank.

Select All [Ctrl + A]
Makes a selection of all strokes on the canvas. Affected by whether the Cross Layer
Operations mode and / or the Cross Cel Operations mode is enabled.

Select by Stroke Type
Normal Strokes
All Color Separation Lines
Red Color Separation Lines
Green Color Separation Lines
Blue Color Separation Lines
Cyan Color Separation Lines
Pink Color Separation Lines
Yellow Color Separation Lines
Makes a selection of all strokes of a similar type on the canvas. Affected by whether
the Cross Layer Operations mode and / or the Cross Cel Operations mode is enabled.
Strokes of Similar Depth
Makes a selection of strokes that have the same stroke depth as the initial selected
stroke. You will need to select a stroke first. Affected by whether the Cross Layer
Operations mode and / or the Cross Cel Operations mode is enabled.

Deselect [Ctrl + D]
Clears any current selection of strokes.

User Manual
(1.x) (Enable / Disable) All Layers
(1.x) (Enable / Disable) All Frames
Moved to Objects menu, Drawing Controls option.

(1.x) Canvas…
Moved to File menu.

(1.x) Set Auto Save Location
(1.x) Set Auto-saving Intervals
Integrated into Autosave Settings… option in File menu.

(1.x) Reset Panel Locations
Moved to View menu.

01 02 03 04 05 06 07 08 09 10 11
The Menu Bar

| CACANi

Objects Menu

Move
Up 1 Pixel / Down 1 Pixel / Left 1 Pixel / Right 1 Pixel
Translates the chosen strokes by a single pixel in the stated direction.
Up 10 Pixels / Down 10 Pixels / Left 10 Pixels / Right 10 Pixels
Translates the chosen strokes by 10 pixels in the stated direction.

Rotate
Rotate Right 90° / Rotate Left 90°
Rotates the selected objects by 90° clockwise / 90° counter-clockwise respectively.
Flip Horizontal / Flip Vertical
Reverses selected objects left to right / up to down respectively.

Arrange
Bring to Front
Moves selected groups to the front of all other groups.
Bring Forward
Moves selected groups one level above the next group.
Send Back
Moves selected groups to the rear of all other groups.
Send Backwards
Moves selected groups one level beneath the next group.

User Manual
Group/Mask
Create Group / Create Mask / Create Clipping Mask
Makes a new group, mask or clipping mask respectively from the selected strokes or
groups.
Create Group for Each Stroke / Create Mask for Each Stroke / Create
Clipping Mask for Each Stroke
Makes a new group, mask or clipping mask respectively for each selected stroke.
Ungroup
Removes the strokes from the selected group.

Masking Level
Cut / Cel / Layer
The mask will hide or reveal strokes across different cels, across different layers
within the same cel, or only within a single layer respectively.
Please see Chapter 08 – Using Stroke Groups and Masks.

Boundary Strokes
Allows a stroke to hide other strokes.
Hide Strokes…
Allows you to designate selected strokes as boundary strokes. You will need to
choose a side (of the boundary stroke) where occluded stroke segments will be
converted into hidden segments. The depth of a boundary stroke is automatically
increased by 1.
Show Strokes…
Allows you to designate selected strokes as boundary strokes. You will need to
choose a side (of the boundary stroke) where occluded stroke segments are
revealed. The depth of a boundary stroke is automatically increased by 1.
Occluded Strokes
These strokes can be hidden by boundary strokes that have the same or higher
depths. A boundary stroke can also be an occluded stroke.
Un-occluded Strokes
These strokes are not affected by boundary strokes. All strokes are un-occluded
strokes by default.
Clear Boundary Settings
Any boundary or occlusion settings will be removed from the selected strokes.
Please see Chapter 08 – Using Boundary Strokes.
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Apply Stroke Tapering
Applies Stroke Tapering function to selected strokes. Stroke Taper settings can be
configured from the Stroke Taper Panel. To use this, the Stroke Taper settings needs
to be enabled for the Selection Tool.
Please see Chapter 04 – Stroke Taper Panel.

Change Stroke Width…
Adjusts the width of selected strokes. You can choose to scale the stroke widths by a
fixed value or a percentage. This feature can also be applied when strokes in
multiple frames are selected.

Please see Chapter 08 – Changing Stroke Widths.

Randomize Strokes (Beta)
Adjusts the curvature of strokes slightly to give a more hand-drawn effect.

Join Strokes
Selected strokes are combined into one single stroke. The selected strokes have to
be touching end to end.
Please see Chapter 08 – Using Join Strokes and Cut Stroke.

Change Stroke Direction
The starting and ending points of a stroke is reversed. This is useful when the stroke
in generated in-between frames is flipped.

Add Stroke Connection Points
Adds data points to every intersection found between strokes. It is applied to all
strokes in a frame by default. You can also apply it to selected strokes and frames.
This is useful to ensure that gaps do not appear when transforming the strokes.
Please see Chapter 08 – Using Stroke Connection Points.

Remove Stroke Connection Points
Remove data points to every intersection found between strokes. It is applied to all
strokes in a frame by default. You can also apply it to selected strokes and frames.
When there’re less points, editing the strokes is easier.
Please see Chapter 08 – Using Stroke Connection Points.

User Manual
Delete All Feature Points
All assigned feature points on a selected stroke are deleted.

Delete Bones from Selected Groups
Allows you to remove bone paths from groups.

Show Previous Stroke (Onionskin)
Allows you to revert to a previously unmatched stroke.

Show Next Stroke (Onionskin)
Allows you to skip the next unmatched stroke.

Re-match Stroke Order
Allows you to change the index number of selected strokes (on the Canvas) to match
the selected strokes in the Matching Frame (Navigator Panel, Matching Frame
mode).
Please see Chapter 08 – Using Re-match Stroke Order.

Reduce Stroke Order (Current Layer)
Analyses the frames in the active layer and reduces the number of stroke indices that
do not have a stroke in any frame. Doing this will not improve performance
significantly, but it can help you have a more accurate view of the stroke number in
each frame.

Drawing Controls
Cling to Stroke Mode
When enabled, the cursor will snap to the nearest stroke. Using in Drawing Tools and
Stroke Editor. When Ctrl is held down, both Cling modes are reversed.
Cling to Stroke End Mode
When enabled, the cursor will snap to the nearest stroke end. Using in Drawing Tools
and Stroke Editor. When Shift is held down, this mode is reversed. When Ctrl is held
down, both Cling modes are reversed.
Cling Range
You can adjust the range (based on screen pixels) at which the clinging will come into
effect. At higher zoom levels, the perceived range will be smaller.
Add Points When Clinging
When enabled, after snapping to a stroke, a connection point is also added to the stroke. This
helps to ensure that gaps will not appear between connected strokes when they are scaled or
rotated together. However, while additional connection points do not affect the strokes, when
generating inbetween frames, they can result in more jittery or bumpy strokes.
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Cross Layer Operations Mode
When enabled, you can select and edit strokes in different layers, without having to
select the layer first.
Cross Cel Operations Mode (Beta)
When enabled, you can select and edit strokes in different layers, without having to
select the cel or layer first. Currently, only selection of strokes is supported.
New Stroke Index Mode
When enabled, any unmatched strokes will be disregarded, and strokes drawn will be
assigned new stroke index numbers. This is needed when drawing new elements that
are not in the previous key frame, and unmatched strokes exist in the current frame.
Auto Group Mode
When enabled, every stroke drawn will be grouped individually. This is useful when
trying to change the behavior of the inbetween animation (through the Bone Tool).
Auto Add Feature Point Mode
When enabled, every stroke drawn will have feature points added to the its ends
automatically. This is useful when trying to change the behavior of the inbetween
animation.
Please see Chapter 04 – Drawing Controls.

Separate Single Layer/ Cross Layer Paint Operations
Mode
When enabled, the Single Layer Paint Tool and Cross Layer Paint Tool will only be able
to color their respective region types.

Image
Fit to Camera
Resizes the selected image in the Image layer to fit within the resolution of the camera
frame.
Fit to Camera Size / Fit to Camera Height
Resizes the selected image in the Image layer to fit within the horizontal / vertical
resolution of the camera frame respectively.
Fit Camera to Selected Images
Resizes the camera frame to match the resolution of the selected image. When
multiple images are selected, the combined resolution of the selected images are
used. The selected images will also be moved to the center of the canvas as well.
Reset Position
Moves the selected images back to the center of the canvas.

User Manual
Reset Size
Resizes the selected images to their original resolutions.
Reset Rotation
Returns the selected images to their original orientations.

Add Video Reference…
Loads a video on the canvas for reference. Unlike the videos in a Video Layer, the
frames of the video are not mapped to the layers in the Cel Bank.
Please see Chapter 05 – Using Video Reference.
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(1.x) View > Canvas

(1.x) Show Camera Frame
(1.x) Show Grid
(1.x) Show Field Chart
Moved to View menu, Canvas Display Options.

(1.x) Show Strokes’ Size
(1.x) Show Strokes’ Directions
(1.x) Show Invisible and Hidden Strokes
(1.x) Fade Non-Active Layer Strokes
Moved to View menu, Stroke Display Options.

(1.x) Gray Out Matched Strokes (Navigator only)
(Only applicable to Navigator Panel, Reference Frame mode Enabled) Displays strokes
that are already matched or corresponded will be as gray strokes, instead of the
strokes’ original color. Moved to File menu, Customise Shortcuts option, Others tab.

(1.x) Show Stroke Gaps
(1.x) Show Hidden Stroke View
(1.x) Show Color Sep strokes
(1.x) Show Layer Tag Colors
Moved to View menu, Stroke Display Options.

(1.x) Toggle Onion Skin
Moved to View menu.

(1.x) Show Pins
(1.x) Apply Anti-Aliasing to Strokes
Moved to View menu, Stroke Display Options.

User Manual

(1.x) View > Color Regions

(1.x) Hide Region Colors
(1.x) Show Region Colors
(1.x) Highlight Self Regions
(1.x) Show Closed Regions
(1.x) Show Painted Regions
(1.x) Show Closed Self Regions
Moved to View menu, Region Display Options.

(1.x) View > Quick Flip

(1.x) Quick Flip Forward
(1.x) Quick Flip Backward
Moved to Playback menu, integrated as Quick Flip option.
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Layer Menu

New Cel
Creates a cel above the selected cel in the Cel Bank.

New Drawing Layer
Creates a drawing layer above the selected layer in the Cel Bank.

New Sketch Layer
Creates a sketch layer above the selected layer in the Cel Bank.

New Raster Layer
Creates a raster layer above the selected layer in the Cel Bank.

New Color Separation Layer (Red, Blue, Green, Cyan,
Pink, Yellow)
Creates a color separation layer above the selected layer in the Cel Bank. Strokes
drawn within the layer will not be shown in the final exported images.

New Image Layer
Creates an image layer above the selected layer in the Cel Bank.

New Video Layer
Creates a video layer above the selected layer in the Cel Bank.

New Audio Layer
Creates an audio layer above the selected layer in the Cel Bank.

User Manual
Rasterize Image Layer
Converts the image layer into the raster layer. You can use this option to turn external
images into the CACANi raster format for further editing.

Extract Line Art…
For Raster Layer only. Allows you to extract drawings and turn the background
transparent.

Vectorize Layer…
Converts Raster or Image Layers into Drawing Layers. Allows you to convert the raster
drawings into vector strokes. Raster region colors are not supported.

Duplicate Cel / Layer
Clones the contents of the selected cel or layer and place it in a new cel or layer above
the current selected one.

Remove Cel
Deletes the selected cel.

Remove Layer
Deletes the selected layer.

(1.x) Hide/Unhide Layer(s)
(1.x) Lock/Unlock Layer(s)
(1.x) Toggle Onion Skin for Layer(s)
Removed from Layers menu. Controls available in Cel Bank.

Select Similar Layer Type
Picks layers that are of the same type as the selected layer. This can be used to
quickly change layer statuses for multiple layers.

Select All Other Layer Types
Picks layers that are not of the same type as the selected layer.

Select Layer Above / Select Layer Below
Selects the layer above the current active layer / beneath the current active layer.

Start Cel at Frame… / End Cel at Frame…
Moves selected cels so that they start or end at the chosen frame.
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Frames Menu

New Key Frame to Left / New Key Frame to Right
A new key frame is inserted before/after the selected frame.

New Inbetween Frame to Left / New Inbetween Frame
to Right
A new in-between frame is inserted before/after the selected frame.

Duplicate Frame to Left / Duplicate Frame to Right
A clone of the selected frame is made and inserted before/after the original frame.

Duplicate Frame…
Allows you to create a copy of your selected frames.

Hold Frame
Extends the duration of your selected frames.

Repeat Frame
Repeats the contents of a frame. Unlike Hold Frames, Repeat Frames can be placed
anywhere in the same sequence.

Generate Inbetween Frames
Allows you to create in-between frames for a pair of key frames.

Inbetween Selected Strokes
Generates or re-generates selected strokes in In-between frames, without changing
the other non-selected strokes. Selected strokes can be in the Key frames or in the
In-between frames.

User Manual
Add Inbetween Frames to Entire Cel…
Allows you to create a fixed number of in-between frames for all key frames in a cel.

Skip Inbetween Generation for Frame
Marks the selected in-between frame so that it is not affected by Generate Inbetween
Frames option. This is used when you have added made changes to the drawings in
the in-between frame and do not want them to be cleared.

Retain Stroke Connections (In-betweens)
Analyses all inbetween frames for any T intersection gaps and compares them with
those in the key frames. If the same strokes in the key frames are connected, CACANi
will close the gaps.
Please see Chapter 08 - Retain Stroke Connections.

Transfer Grouping Info
Based on the same stroke indices, the grouping information in the source frame is
replicated to selected destination frames. However, for strokes that are already
grouped in destination frames, they will not be changed.

Replace Grouping Info
Based on the same stroke indices, the grouping information in the source frame is
replicated to selected destination frames. Existing groups in destination frames are
overwritten.
Please see Chapter 08 – Animating Groups and Masks.

Transfer Boundary Stroke Settings
Based on the same stroke indices, the boundary stroke settings in the source frame is
replicated to selected destination frames. Existing boundary or occluded strokes in
destination frames are overwritten.
Please see Chapter 08 – Animating Boundary Strokes.
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Update Selected Occluded Strokes
When the Auto Update Occluded Strokes option is disabled, you can use this feature
to manually update the visibility of selected occluded strokes. The feature can be
performed on the active frame or on multiple selected frames.
Please see Chapter 08 – Editing Occluded Strokes Manually.

(1.x) Adjust Stroke Size (Multi-Frame)
Integrated into Objects menu, Change Stroke Size… option.

Convert to Key Frames
Changes the selected frames into key frames.

Convert to Empty Key Frames
Deletes the contents of the selected frames before changing them into key frames.

Convert to Inbetween Frames
Changes the selected frames into in-between frames.

Convert to Empty Inbetween Frames
Deletes the contents of the selected frames before changing them into in-between
frames.

Convert to Hold Frames
Changes the selected frames into hold frames. The original contents of the frames are
deleted.

Clear Sheet / Clear Frame / Clear All Inbetween Sheets
Clear all strokes in the selected sheets / frames / all In-between sheets.

Remove Frame
Deletes selected frames from the Cel Bank.

Remove All Inbetween Frames
Deletes selected In-between frames from the Cel Bank.

Hide/Unhide Raster Sheet
Temporarily turns off the drawing in a selected sheet. For raster layers only.

User Manual

Playback Menu

Start Playing
Plays back the animation sequence.

Display Next Frame
Selects the frame to the right of the active frame.

Display Previous Frame
Selects the frame to the left of the active frame.

Display Next Key
Selects the nearest key frame to the right of the active frame.

Display Previous Key
Selects the nearest key frame to the left of the active frame.

Skip Hold Frames
When enabled, Hold Frames are ignored while using the above frame display options.

Quick Flip
Allows you to preview the animation from the previous key frame to the next key
frame by generating in-between frames temporarily.
Please see Chapter 08 – Quick Flip.

Display Previous Video Reference Frame
Shows the previous frame of a Video Reference file.

Display Next Video Reference Frame
Shows the next frame of a Video Reference file.
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(1.x) Tools Menu

(1.x) Retain Stroke Connections (In-betweens)
Moved to Object menu.

(1.x) Go Previous Curve
Moved to Object menu.

(1.x) Skip Next Curve
Moved to Object menu.

(1.x) Auto Save
Moved to File Menu.

(1.x) Color Reference Window
Moved to View menu.

(1.x) Remove Redundant Place Holder for Current Layer
Moved to Object menu.

(1.x) Clear Undo/Redo History
Moved to Edit menu.

(1.x) Remove Hooks (Experimental)
Analyses the stroke ends in a current drawing and truncates unwanted small hooks.
Option removed.

(1.x) Switch Cursor
Moved to Canvas Display Options.

(1.x) New Coloring Mode
When enabled, limits the Single Layer Paint Tool to only apply color in Single Layer or
single layer regions (regions formed from strokes in one layer). When disabled, the
Single Layer Paint Tool will still apply color to cross layer regions (regions formed from
strokes in multiple layers). It is enabled by default. Option removed.

(1.x) Use TabletPC (Experimental)
Moved to File menu.

User Manual

View Menu

Canvas Zoom In [Ctrl + Space + Mouse Drag Right], [=]
Magnifies the view of the canvas.

Canvas Zoom Out [Ctrl + Space + Mouse Drag Left], [-]
De-magnifies the view of the canvas.

Canvas Rotate Right [Shift + Space], [0]
Rotates the canvas clockwise by 15 degrees.

Canvas Rotate Left [Shift + Space], [9]
Rotates the canvas counter-clockwise by 15 degrees.

Flip Canvas Horizontal
Flips the canvas left to right.

Flip Canvas Vertical
Flips the canvas up to down.

Reset Canvas
Removes any rotation, magnification and movement of the canvas.

Reset Rotation
Removes any rotation of the canvas.

Reset Zoom
Removes any resizing of the canvas.
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Reset Translation
Removes any movement of the canvas and moves it back to the center of the
workspace.

Disable Double-Click to Reset
When enabled, you cannot use double clicking to reset the canvas’ rotation, zoom
level or position (with the Zoom, Pan and Rotate tools). This can be helpful if you
find that the double click interaction affects your use of the tools.

Canvas Display Options
Please see Chapter 06 - Canvas Display Options.
Show Camera Frame
Displays the camera frame on the canvas.
Show Crosshairs
Displays the center point of the camera frame.
Show Field Chart
Displays an animator’s field chart within the camera frame.
Show Animation Details and Peg Holes
Displays the Scene or Cut Number, Description and Duration of the current file. Also
displays the traditional peg holes found on animation paper.
Show Grid
Displays a grid over the entire canvas.
Show Status
Displays various details about the CACANi software.
Switch to Small Cursor
When enabled, cursor is rendered in software and cursor icons will not be displayed.

Stroke Display Options
Please see Chapter 06 - Stroke Display Options.
Show Stroke Widths
Disables thickness of strokes and displays the centerlines only. Can speed up
responsiveness of the canvas.
Show Stroke Directions
Indicates the direction of a stroke with colored arrows.

User Manual
Show Gaps
Indicates unconnected stroke ends.
Show Invisible / Hidden Strokes
Displays invisible and hidden strokes and stroke segments on the canvas.
Show Color Separation Strokes
Displays color separation strokes on the canvas.
Lighten Strokes in Inactive Layers
Distinguishes between strokes in active (selected) and inactive (unselected) layers.
Show Hidden Stroke View
Fades out normal strokes, while invisible and hidden strokes are bolded.
Show Layer Tag Colors on Strokes
Displays stroke colors based on their layer color tags.
Show Intersection and End Points
Indicates intersection points between strokes as well as the end points of each stroke.
Show Stroke Number when Hovering
Displays the index number of a stroke when the cursor hovers above them.
Auto Update Occluded Strokes
Refreshes the visibility of occluded strokes immediately when boundary strokes are
edited. When disabled, you can use the Update Selected Occluded Strokes option to
update the visibility manually.
Show Boundary Indicators and Depth
Displays visual indicators when boundary or occluded strokes are selected. The
selected stroke’s depth value is shown in brackets.
Show Anti-Aliasing in Strokes (Vector)
Displays vector strokes with edge smoothening on the canvas.

Region Display Options
Please see Chapter 06 - Region Display Options.
Show Region Colors
Displays painted regions with their respective colors.
Hide Region Colors
Disables the display of painted regions.
Highlight Closed Regions
Indicates all regions that are ready for painting in multiple colors.
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Highlight Single Layer Regions
Indicates all single layer regions in all layers with checkered colors.
Highlight Closed Single Layer Regions
Displays only single layer regions found on the active layer.
Highlight Painted Regions as Black
Indicates all filled regions in black.
Always Update Region Colors
When enabled, CACANi will refresh the region colors after almost every user action.

Onion Skin Display Options
Please see Chapter 08 – Onion Skin Settings.
Show Onion Skin Images
Displays strokes from other frames as an onionskin image.
Show Onion Skin Images for Key Frames Only
Disables the display of painted regions.
Loop Onion Skin Images
Displays painted regions with their respective colors.
Switch Matching Frame Direction
Changes the Matching Frame in Navigator Panel to display the strokes from the next
Key Frame.
Reset All Onion Skin Image Colors
Disables the display of painted regions.
Reset All Offpeg Frame Colors
Displays painted regions with their respective colors.
Show Offpeg Frames
Disables the display of painted regions.
Clear All Offpeg Frames
Displays painted regions with their respective colors.

(1.x) Auto Pan Reference Frame
Renamed Synchronize Pan. Moved to Navigator Panel, Matching Frame Settings.

Change Centerline Display…
Allows you to adjust the thickness of the centerline of a stroke.
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Panel Display
Displays the various tool panels.

Hide All Panels
Turns off all tool panels and displaying only the canvas.
Please see Chapter 02 - Panel Access Bar.

Reset Panel Locations
Reverts the various tool panels to their default positions.

Color Reference Window
Opens up a window that allows you to load an image for color reference.
Please see Chapter 09 – Using the Color Reference Window.

Minimized Frame View (Cel Bank)
Reduces the width of the displayed frames in the Cel Bank. This is helpful as you can
see more frames in the same amount of space.

Hide Stroke Numbers (Cel Bank)
Hides the stroke numbers displayed in each sheet in the Cel Bank.
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Help Menu

CACANi Help…
Directs you to our online Help document.

CACANi Tutorials…
Directs you to our online Tutorials page, where you can view video tutorials about
the various tools in CACANi. You can also download some sample CACANi files here.

CACANi Forum…
Directs you to our online forum, where you can post questions and comments to the
CACANi community.

About CACANi…
Shows information about the CACANi software.

Subscription…
Allows you to manage your subscription. You can view subscription information,
extend subscription with a new product key or deactivate the subscription to
transfer to another computer.

View Production Information…
Shows information about the currently opened CACANi file. Information can be
exported as a text file.
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Quick Start Guide
Making animation drawings is the focus of CACANi. The Canvas is your paper, the
Tools Panel are your drawing instruments, and the Cel Bank is where you manage
the unlimited supply of paper for your animation. This guide will walk you through
some of the essential tools to complete an animation in CACANi.
To start drawing in CACANi, it is as simple as choosing the Pen Tool and scribbling
away on the canvas. You can also use the Eraser Tool to remove unwanted strokes.

The Undo (Ctrl + Z) and Redo (Ctrl + Y) buttons help you to return to a previous state
of your actions.

You can zoom in or out of the canvas by Holding Ctrl + Space, move around the
canvas by Holding Space, or rotate the canvas by Holding Shift + Space, then Hold
Left Click and Drag the cursor in the canvas.
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The Raster Layer allows you to draw and erase on a pixel-based canvas. The
experience is closer to pencil and paper, but the disadvantage is that you will not be
able to make use of the automated inbetweening and coloring features.

You can make use of the Color Separation Lines to draw shadow and highlight lines.
In a Raster Layer, the Color Separation Lines are always under the black strokes.

You can create more key frames by using the Frame Control buttons. A key frame
has a short line drawn at the bottom. However, do take note that Raster frames do
not have the short line to indicate it’s a key frame.

User Manual
When you’re on the second frame and want to use the previous drawing as a guide,
you can enable the Show Onion Skin Images option from the Display Property Bar.

After your sketches are done, you can play back the sequence. You can also quickly
toggle between the 2 key frames using [F] and [G] keyboard shortcuts. Because
there’s only 2 frames, the animation is too fast.
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To increase the length of the animation, you can draw more frames by hand. Or you
can make use of CACANi’s automated inbetweening feature to generate more
frames. But to do that, you need to clean up the drawing using the Drawing Layer. It
allows you to draw sharp, resolution-independent vector strokes. By default, a
Drawing Layer, Layer 1, is created.

Switch to Key Frame 1 on the Drawing Layer. You can still use the Pen Tool, or you
can also use the other Curve and Bezier Drawing Tools.

As the sketches are too dark, you can reduce the layer opacity using the Opacity
slider. Hold Left Click and Drag down on the slider. The sketch is now translucent.

User Manual
Select the Curve Tool. Increase the Stroke Width to your desired thickness. Left Click
once on the top of the head and Left Click again along the edge until you reach the
bottom of the head. You can use keyboard shortcuts to move the canvas in the
middle of drawing a stroke. Left Click Twice to end the stroke.

When drawing the next stroke, you can ensure that the strokes are connected by
making sure that you see the red cling indicator when you start or end your stroke.
This is a very important step because it helps you paint the drawings later.

When you hover over each stroke, you can see the stroke number or stroke index.
This is very useful when you are matching strokes to other key frames. The total
stroke number is also indicated in the frame.
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After drawing a stroke, you can adjust its curvature with the Stroke Editor.

After completing the first key frame, you can repeat the process to clean up the
second drawing. However, because the onion skin feature is enabled for both layers,
it can be difficult to see the correct strokes. You can turn off the onion skin feature
for the raster layer.

When cleaning up the second drawing, it is important to follow the stroke arrows in
the onion skin image. For example, if the arrows indicated drawing the face first and
you drew the mouth instead, the automated inbetweening will not work properly
later.

Drawing the face, same as
the stroke arrow indicators

Not following the stroke
arrow indicators

User Manual
After drawing a few strokes in the second key frame, you can check your clean up
easily by using the Quick Flip button. Temporary frames are generated so that you
can see whether you made any errors in the clean up.

When the second key frame is completed, you can now add blank inbetween frames
to your animation sequence. Make sure that the blank inbetween frames are in the
middle of the 2 key frames that you have drawn.

Left Click Twice on any of the blank inbetween frames. They will now be generated
based on your key frames. You can now play the animation properly using the
Playback button.
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You can now paint the drawings. Select the Cross Layer Paint Tool and Left Click
Twice on the Color Selection Box to pick a color. After selecting your color, Left Click
on the region to paint it. You can also Right Click to remove a color from a painted
region.

After the first key frame is painted, you can bring up the Auto Color Panel to help
you help the rest of the frames. With the first key frame still selected, you can select
the Auto Color Other Frames option.

Using your first key frame as reference, CACANi will paint the rest of the frames.

User Manual
If you find that there are some unpainted or wrongly painted regions, it is likely that
there were some open regions. When that happens, you should be able to see
orange indicators telling you that there are unconnected stroke ends.

To do a touch up, you can select the Region Gap Close option in the Cross Layer
Paint Tool properties.

Then Hold Left Click and Drag over the uncolored region. The dragging allows you to
decide the size of the gaps that should be closed. Nearby gaps will be closed.
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When the uncolored regions are painted, your animation is ready to be exported.
You do not want to see the color separation lines, so turn them off from the Display
Bar.

From the File menu, you can choose to export the sequence as a video.

You may want to give your animation a different name, but otherwise you do not
need to change anything in the Export Video window.

Your animation is complete!

User Manual

The Tools Panel
However, without the right tools you will end up wasting time on non-creative and
repetitive tasks. To help you overcome that, we have designed tools that will help
make the process of animation faster.

Common Tool Properties
There are a number of tools which share similar property controls. For example, the
Pen Tool shares many similar properties with the Curve and Bezier Tools. As such,
we’ll have a more thorough explanation when the property is first listed, while
subsequent similar properties will only make references to these descriptions.

Drawing Tools
Of all the tools, the Drawing Tools are probably the most frequently accessed. These
are used for the creating of your drawings in CACANi.

Pen Tool

Single Curve Tool

Curve Tool

Bezier Tool

Ellipse Tool

Polygon Tool

Eraser Tool

Segment Eraser

Stroke Eraser

Tool

Cling Shortcut Keys
Clinging is a method that forces strokes to snap to each other, while drawing or editing
strokes.
When using the Pen, Single Curve, Curve and Bezier Tools to draw, or the Stroke
Editor to edit strokes, you can Hold Down Ctrl to toggle both Cling to Stroke End and
Cling to Stroke. Alternatively, you can Hold Down Shift to toggle Cling to Stroke End
only.
Both shortcut keys, when held down, Switch the mode of the Cling functions. For
example, when Cling to Stroke End is Disabled in the Drawing Controls Bar, holding
down Shift will Enable the function.
Please see Chapter 04 – Cling to Stroke End for more information on its uses.
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Handling Sharp Angles in Strokes
When a drawing is going to be automatically in-betweened, care must be taken in
areas of the drawing where the strokes have sharp angles. It is recommended to use
a separate stroke for each side of the angle. This will allow a better in-between
result.
See Chapter 08 – In-betweening Sharp Angles.

Pen Tool
Allows you to draw strokes freely on the canvas. With a pressure sensitive stylus, you
will also be able to create strokes of variable width.
Drawing can be done either using a tablet or the mouse. To draw using the mouse,
press down the left mouse button and drag to form a path. A stroke will be created
from the path and the stroke will have a constant stroke width.

To draw using the tablet, press the stylus down on the tablet to begin. As with the
mouse, drag the stylus in this manner to form a path and lift the stylus to end the
stroke. Using the pressure-based information from the stylus, the curve width will
vary accordingly for the stroke.

Drawn with mouse

Drawn with stylus

After the stroke is created, it will be smoothed according to the Smoothing Property
in the Property Window. This applies to both strokes drawn using the mouse and the
stylus.
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Pen Tool Properties

1

2

3

4

5

6

7

8

9

1

Maximum Size
You can set the maximum width of a stroke by dragging the slider or Left Clicking
and typing a specific value.
Strokes at different
widths

2

Minimum Size
You can set a stroke’s minimum width by dragging the slider or Left Clicking and
typing a specific value. By setting a minimum width, you can make use of the
stylus pressure to drawing strokes of varying thickness. You will require a graphic
tablet to make use of this feature.
Strokes at different
minimum widths

3

Sync Stroke Width
Allows you to synchronize the Maximum Size, or maximum stroke width property
for all the drawing tools.
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Opacity
You can set the opacity / transparency of the stroke by dragging the slider or Left
Clicking and typing a specific value.
Opacity of the curve to be drawn is set by dragging the slider or Left Clicking and
typing a specific value. The higher the value, the less transparent the curve will
appear.
Strokes at different
opacity values

5

Smoothing
In the Pen Tool, strokes are drawn by tracking your mouse or pen device
continuously across the screen. However, this tends to create many data points
in each stroke. The stroke does not look smooth and editing so many points is very
troublesome. Smoothing options help you to generate strokes that follow your
drawing movements closely yet have the minimum number of data points.

There are 3 smoothing modes. Both the Normal Smooth and Medium Smooth
modes work by collecting and averaging data points as you draw with the Pen
Tool. You can change the smoothness of the stroke by dragging the slider or Left
Clicking and typing a specific value. The larger the value, the smoother the stroke
and the lesser points there are.

User Manual
In contrast, the Accurate Smooth mode works by generating the smoothed stroke
only after you finish drawing. There is no value adjustment for the Accurate
Smooth mode, so the slider is disabled.

6

Stroke Color Selection Box
You can set the stroke color by Double Clicking to bring up the Color Selection
Box dialog box. When done, just Left Click OK to confirm.

Double Click on Stroke
Color Selection Box

7

Stroke Rendering Modes
Allows you to draw a stroke with Normal, Closed, Invisible, Hidden or Color
Separation properties.
Please refer to Chapter 04 – Stroke Rendering Modes.

8

Auto Direction (*experimental feature)
When enabled, CACANi will try to anticipate the stroke direction when matching
strokes. However, when the matching stroke in the new frame has a difference of
more than 180 degrees compared to the stroke in the previous frame, it will result
in an ambiguous stroke direction error message.
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(1.x) Invisible Gaps
With this enabled, when you finish drawing a stroke and the stroke end is near
another stroke (based on the Cling threshold value), the stroke will be extended
with an invisible segment to form a connection with the nearby stroke. Removed
due to change in Cling function.
9

Drawing Modes
Drawing Modes act like rulers, allowing you to draw straight strokes based on the
selected mode.
Normal Drawing Mode
Drawing Modes are disabled.
Grid Drawing Mode
Strokes are confined to vertical or horizontal straight lines.
Parallel Drawing Mode
Strokes are confined to straight lines at the specified angle.
Radial Drawing Mode
Strokes are confined to straight lines radiating from the Pivot Point.
Pivot Point
With this enabled, you can select the Pivot Point on the canvas and move it
to either adjust the angle of the straight lines in Parallel Drawing Mode, or
to re-locate the convergent point of the strokes in Radial Drawing Mode.
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Pen Tool Properties (Raster Layer)

1

2

3

4

5

6

7

8

9

10

In CACANi 2.0, we are introducing the new Raster Layer. You will find some different
properties when changing between the drawing and raster layer.
1

Size
Sets the maximum width of a stroke.

2

Opacity
Sets the opacity / transparency of a stroke.

3

Smooth
Generates smoother strokes by collecting and averaging inputs from your mouse
or stylus as you draw. You can change the smoothness of the stroke by dragging
the slider or Left Clicking and typing a specific value. The larger the value, the
smoother the stroke.

4

Pen Color
Controls how much the existing background color is affected by the selected pen
color. In the example below, the selected pen color is black. At 0%, the selected
pen color is not considered and the existing background color at the start of the
drawing replaces the selected pen color.
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As the value increases, more of the pen color is mixed with the background color.
So the black pen color is mixed with the background red or background blue
respectively.

At 100%, the pen color is used and no mixing with the background color is done.

5

Blend
Controls the amount of color mixing when drawing. When the blend value is 0%,
no blending occurs.

User Manual
As the blend value increases, the background color will have a stronger influence
on the pen color.

When both the pen color and blend values are used together, the selected pen
color will influence the color mixing. In this case, the black pen color is now
affecting the red and blue background colors.

6

Stroke Color Selection Box
You can set the stroke color by Double Clicking to bring up the Color Selection
Box dialog box. When done, just Left Click OK to confirm.
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Color Separation Modes (Raster Layer)
Allows you to draw highlight or shade lines for painting later.
While they are similar conceptually to the Color Separation Strokes mentioned in
Chapter 04 – Stroke Rendering Modes, there is a difference in how you use them.
You can think of each stroke color as a sublayer of the raster layer. When you use
the red color separation pen, you are drawing on a sublayer beneath the black
stroke sublayer. Whereas in the Drawing Layer, the color separation strokes are
not divided into sublayers. The eraser will also erase only the specific color
separation stroke.

8

Anti-Alias
Applies anti-aliasing to the edge pixels, making the strokes look smoother.

9

Airbrush
Blurs the edge pixels to achieve a softer brush effect when drawing.

User Manual
10

Pressure
Allows you to control the various pen properties, Size, Opacity, Brush Density or
Blend with stylus pressure. You will require a graphic tablet to make use of this
feature.

Single Curve Tool
Allows you to draw a stroke, by first dragging from the starting to the ending point,
then adjusting the curvature with the cursor and keyboard shortcuts.

Drag to ending point
and Left Click

Hover to adjust stroke

Left Click again to
confirm stroke

While drawing, the curvature can be changed with shortcuts [ [ ] and [ ] ] after
setting the ending point.

Decrease Curvature [ [ ]

Increase Curvature [ ] ]
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Single Curve Tool Properties

1

2

3

4

5

6

7

8

1

Size
Sets the maximum width of a stroke.

2

Sync Stroke Width
Allows you to synchronize the Maximum Size, or maximum stroke width property
for all the drawing tools.

3

Curvature
You can set the curvature of the stroke by dragging the slider, or Left Clicking and
typing a specific value.

Curvature at 0

Curvature at 100

4

Opacity
Sets the opacity / transparency of a stroke.

5

Points
Sets the number of data points on the stroke. With more data points, refined
adjustments to the stroke can be made, but it can also be too time-consuming.

2 points

7 points

30 points

User Manual
6

7

8

Stroke Color Selection Box
Sets the color of the strokes being drawn.
Stroke Rendering Modes
Allows you to draw a stroke with Normal, Closed, Invisible, Hidden or Color
Separation properties.
Please refer to Chapter 04 – Stroke Rendering Modes.
Auto Direction (*experimental feature)
When enabled, CACANi will try to anticipate the stroke direction when matching
strokes. However, when the matching stroke in the new frame has a difference of
more than 180 degrees compared to the stroke in the previous frame, it will result
in an ambiguous stroke direction error message.
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Curve Tool
Allows you to draw a smooth stroke by creating a sequence of points. Left Click on
the canvas to create points for the stroke, and Right Click to end the stroke.

Create a series of points

Stroke drawn based on
points

Curve Tool Properties
Please refer to Chapter 04 - Single Curve Tool Properties.

Bezier Tool
Allows you to draw a discontinuous stroke by creating a sequence of points. Straight,
discontinuous segments are created when Left Clicking only, while holding down Left
Click and Dragging will create curved stroke segments.

Left Clicking only

Hold Left Click and Drag

Bezier Tool Properties
Please refer to Chapter 04 - Single Curve Tool Properties.
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Ellipse Tool
Allows you to draw an ellipse or circle. Dragging the cursor will create an oval shape.
To create a circle, Hold Ctrl while dragging.

Normal Drag

Ctrl + Drag

Ellipse Tool Properties

1

2

3

4

5

6

7

8

9

1

Size
Sets the maximum width of a stroke.

2

Sync Stroke Width
Allows you to synchronize the Maximum Size, or maximum stroke width property
for all the drawing tools.

3

Opacity
Sets the opacity / transparency of a stroke.

4

Width and Height (Resizing)
Size and Height of the ellipse, in pixels. Change either value by dragging the slider,
or Left Clicking and typing a specific value.

5

Maintain Aspect Ratio
When enabled, changing either the width or height of the ellipse will lead to a
corresponding change in the other.

6

Fixed Dimension
When enabled, all newly created polygons will be the same pixel width and height
as stated in the Width and Height input fields.
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Start From Center
When enabled, the creation of an ellipse will always start from the center.

Normal

8

9
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Start from Center enabled

Stroke Color Selection Box
Sets the color of the strokes being drawn.
Stroke Rendering Modes
Allows you to draw a stroke with Normal, Closed, Invisible, Hidden or Color
Separation properties.
Please refer to Chapter 04 – Stroke Rendering Modes.

Polygon Tool
Allows you to draw a polygon. Dragging the cursor will create a polygon. To create
regular polygons, Hold Ctrl while dragging.

Normal Drag

Ctrl + Drag
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Polygon Tool Properties

1

2

3

4
1

5

6

7

8

9

10

1

Size
Sets the maximum width of a stroke.

2

Sync Stroke Width
Allows you to synchronize the Maximum Size, or maximum stroke width property
for all the drawing tools.

3

Opacity
Sets the opacity / transparency of a stroke.

4

Width and Height (Resizing)
Width and Height of the polygon, in pixels. Change either value by dragging the
slider, or Left Clicking and typing a specific value.

5

Maintain Aspect Ratio
When enabled, changing either the width or height of the polygon will lead to a
corresponding change in the other dimension.

6

Fixed Dimension
When enabled, all newly created polygons will be the same pixel width and height
as stated in the Width and Height input fields.

7

Start From Center
When enabled, the creation of an ellipse will always start from the center.

8

No. of Sides
You can create polygons with different number of sides by changing the value in
the spin box.

9

Stroke Color Selection Box
Sets the color of the strokes being drawn.

10

Stroke Rendering Modes
Allows you to draw a stroke with Normal, Closed, Invisible, Hidden or Color
Separation properties.
Please refer to Chapter 04 – Stroke Rendering Modes.
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Eraser Tool
Allows you to erase strokes by dragging over them.

Eraser Tool Properties

1

2

3

4

1

Size
By changing the width of the Eraser Tool, the erasing area will be larger.

2

Round Ends
When enabled, the ends of the erased stroke segments will be rounded.

3

Erase From Ends
When enabled, strokes can only be erased from their ends.

4

Pressure
When enabled, the stylus pressure will affect the size of the erasing area. You
will require a graphic tablet to make use of this feature.
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Eraser Tool Properties (Raster Layer)

1

2
1

3

4
1

5

6

7

1

Size
Sets the maximum width of a stroke.

2

Opacity
Sets the opacity / transparency of a stroke.

3

Smooth
Generates smoother erasing areas by collecting and averaging inputs from your
mouse or stylus. You can change the smoothness of the erasing by dragging the
slider or Left Clicking and typing a specific value. The larger the value, the
smoother the erasing.

4

Color Separation Modes (Raster Layer)
Allows you to erase highlight or shade lines. You can think of each stroke color as
a sublayer of the raster layer. When you use the red color separation pen, you are
erasing red pixels on a sublayer beneath the black stroke sublayer.
While they are similar conceptually to the Color Separation Strokes mentioned in
Chapter 04 – Stroke Rendering Modes, there is a difference in how you use them.

5

Anti-Alias
Applies anti-aliasing to the edge pixels, making the strokes look smoother after
erasing.

6

Airbrush
Blurs the edge pixels to achieve a softer brush effect when erasing.

7

Pressure
Allows you to control the various pen properties, Size or Opacity with stylus
pressure. You will require a graphic tablet to make use of this feature.
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Segment Eraser Tool
Allows you to erase stroke segments between intersection points.

Stroke Eraser Tool
Allows you to erase the entire stroke.

Canvas Tools
Canvas Magnifier Tool [ Ctrl + Space + Drag ] or [ 1 ] and [ 2 ]
Allows you to zoom into the canvas by Dragging Right, and zoom out by Dragging Left.

Canvas Pan Tool [ Space + Drag ]
Allows you to move the canvas by dragging.

Canvas Rotate Tool [ Shift + Space ] or [ 3 ] and [ 4 ]
Allows you to rotate the canvas by dragging in a clockwise, or anti-clockwise motion.

User Manual
Camera Tool
Allows you to adjust various camera settings in the property bar. When the tool is
selected, the camera frame is outlined in red on the canvas, with adjustment handles.

Resizing, Rotating, Moving the Camera on the Canvas
To Resize the camera, Left Click and Drag on any of the 8 handles.
If the Maintain Aspect Ratio option is enabled (in Property bar), dragging on any
of the 4 corner handles will resize the camera frame proportionally.
Alternatively you can also Hold Shift while dragging the corner handles.
To Rotate the camera, Left Click and Drag anywhere along the edge of the camera
frame.
To Move the camera, Left Click anywhere within the camera frame and Drag.

Camera Tool Properties

1

3

2

4

5

6

7

8

9

10

11

12

1

Anchor Point
Allows you to reposition the anchor point for the transformation of the camera
frame.

2

Width and Height (Resizing)
Resolution of the camera frame, in pixels. Change either value by dragging the
slider, or Left Clicking and typing a specific value.
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3

Maintain Aspect Ratio
When enabled, changing either the width or height of the camera will lead to a
corresponding change in the other dimension.

4

X and Y (Translation)
Horizontal and Vertical positions of the centre of the camera frame. A positive X
value moves the camera frame right, whereas a positive Y value moves the
camera frame up.

5

Angle (Rotation)
Rotation angle of the camera frame. A positive value rotates the camera frame in
the clockwise direction, whereas a negative value rotates the camera frame in the
anti-clockwise direction.

6

Scale Animation Information with Camera
Locks peg holes and animation information fields so that they can be transformed
proportionally with the camera frame.

7

Customize Animation Information
Allows you to resize the various sections of the animation information module.
For example, this can help you customize the layout to fit your animation paper.

8

Edit Animation Information
Allows you to enter information about the scene or cut.

9

All Frames Mode
When enabled, any changes to the camera frame will be applied to all the frames
in the same layer.

10

Copy Camera Frame
Copies the camera properties in the selected frame.

11

Paste Camera Frame
Applies the copied camera properties into the selected frames.

12

Reset
The translation, scaling and rotation values of the camera frame are reverted to
their original values.
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Offpeg Tool
Allows you to adjust offpeg image settings in the property bar. When the tool and a
offpeg image are both selected (in property bar or Onion Skin), the offpeg frame is
outlined in red on the canvas, with adjustment handles.

Resizing, Rotating, Moving the Offpeg Frame on the Canvas
To Resize the Offpeg frame, Left Click and Drag on any of the 8 handles.
If the Maintain Aspect Ratio option is enabled (in Property bar), dragging on any
of the 4 corner handles will resize the offpeg frame proportionally.
Alternatively you can also Hold Shift while Dragging the corner handles.
To Rotate the offpeg frame, Left Click and Drag anywhere along its edge.
To Move the offpeg frame, Left Click anywhere within the frame and Drag.

Offpeg Tool Properties

1

2

3

4

5

1

Offpeg Frame Selection
Shows the offpeg frame numbers. You can also manipulate offpeg frames by
selecting them here.

2

Scale
Width and Height of the offpeg frame, in pixels. Change either value by dragging
the slider or Left Clicking and typing a specific value.

01 02 03 04 05 06 07 08 09 10 11
Drawing Key Frames

| CACANi

3

X and Y (Translation)
Horizontal and Vertical positions of the centre of the offpeg frame, in pixels. A
positive X value moves the image right, whereas a positive Y value moves the
image frame up.

4

Angle (Rotation)
Rotation angle of the offpeg frame. A positive value rotates the image in the
clockwise direction, whereas a negative value rotates the image in the anticlockwise direction.

5

Reset
The translation, scaling and rotation values of the offpeg frame are reverted to
their original values.

Using the Offpeg Tool
In this example, you need to draw a new frame for the character.

To ensure that the drawing is consistent with the other frames, you can use the Offpeg
frame feature. First, select the 2 frames that will serve as references. You can do so
from the Cel Bank.

User Manual
You can see the frame numbers in the Onion Skin Panel and the Offpeg Tool.

Because the drawings are slightly apart, you will need to position them closer together
to draw your new frame more accurately. To select a frame, you can Left Click on the
frame number in the Offpeg Tool properties, or on the active offpeg frame button in
the Cel Bank. With the Offpeg Tool selected, you can now Left Click and Drag the
Offpeg frame to reposition, scale or resize it in the canvas.

After the drawing is done, you can clear the offpeg frames by Left Clicking on the
Offpeg Frame Indicators in the Cel Bank, or by using the Clear All Offpeg Frames option
from the Onion Skin Panel settings.
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Stroke Rendering Modes
To make hand drawn animation convincing, 3 dimensional movements like turning
and rotation are frequently employed. As a result, the features of an object or
character are always changing, appearing and disappearing in animation sequences.
To help with this aspect of animation production, we have introduced the concept of
Stroke Rendering Modes and Color Separation Modes in CACANi. Strokes or
segments of strokes can be rendered invisible or hidden so that they do not show up
on the exported images.

Normal Stroke Rendering Mode
Strokes drawn are displayed on the canvas and can be exported. They can form closed
regions.

Invisible Stroke Rendering Mode
Strokes drawn are displayed as pink paths on the canvas and cannot be exported.
Invisible strokes or stroke segments cannot be seen, but they can still form closed
regions.

User Manual
Hidden Stroke Rendering Mode
Strokes drawn are displayed as purple paths on the canvas and will not be exported.
Hidden strokes or stroke segments cannot be seen and cannot form closed regions.

Color Separation Modes
In addition to the 3 stroke rendering modes mentioned above, we have another 6
color separation modes to allow you to draw color separation strokes.
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Understanding Color Separation Strokes
These are strokes that you can use to draw regions like highlights or shaded regions
of an object or character. These strokes can be turned off (via the Color Separation
Display Mode) and will not appear in the final export of the drawings.

No Color Separation
Strokes drawn

Color Separation Display
Mode

Color Separation Display
Mode

Enabled

Disabled

Color Separation Modes VS Color Separation Layers
The main difference lies in that when using Color Separation Modes, the strokes are
within the same layer as the normal visible strokes. In addition, the Bone Tool can be
used to group them together with the normal strokes.
The Color Separation Layers are discrete layers, so ALL strokes within are color
separation strokes. However, that means that these strokes cannot be grouped with
strokes in other layers.

User Manual

Drawing Controls
The Drawing Controls holds the drawing mode options and the Undo and Redo tools.
The drawing mode options, when enabled, affect the drawing and selection of strokes
in different ways, so it is best for the artist to learn and be familiar with their usages
in different scenarios.

Cling to Stroke Mode
When enabled, the cursor will snap to the nearest stroke.

Cling to Stroke End Mode
When enabled, the cursor will snap to the nearest stroke end.

Cling Range

You can adjust the range (based on screen pixels) at which the clinging will come into
effect. Note that at higher zoom levels, the perceived range will be smaller.
IMPORTANT: Clinging is a crucial step to ensure the strokes form closed regions for
painting later.
Please see Chapter 05 – Cling Shortcut Keys for more information on its uses.
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Add Points When Clinging
When enabled, after snapping to a stroke, a connection point is also added to the
stroke. When the vertical stroke is moved away, the connection point is removed as
well. This helps to reduce any gaps appearing when transforming the strokes.

Cross Layer Operations Mode
When enabled, you can select and edit strokes in different layers, without having to
select the layer first.

Disabled: Only strokes in
active layer are selected

Enabled: Strokes in all layers
(within cel) are selected

Cross Cel Operations Mode (Beta)
When enabled, you can select and edit strokes in different layers, without having to
select the cel or layer first. Currently, only selection of strokes is supported.

User Manual
New Stroke Index Mode
When enabled, any unmatched strokes will be disregarded, and strokes drawn are
assigned new stroke index numbers. This is needed when drawing new elements that
are not in the previous key frame, and unmatched strokes exist in the current frame.
In the example below, one star moves out of the canvas at Frame 7, and a second star
appears from Frame 8 to Frame 13. Without enabling the New Stroke Index Mode,
CACANi will keep prompting you to draw the first star in Frames 8 – 13.

To draw the above example, 10 strokes are drawn for the first star in the first 2 key
frames, and then 5 in-between frames are generated.

Frame 7
Frame 1

Moving to the empty third key frame (Frame 8), CACANi will prompt you to draw the
matching strokes.

However, from Frame 8 onwards, since the star has disappeared from the canvas, we
do not need to draw the star anymore.
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Hence, to skip the drawing of the first star, enable New Stroke Index Mode. This will
instruct CACANi to disregard the matching strokes in the previous frame, and allow
you to draw new strokes, which in this case, is the second, smaller star.

Now, from Frame 9 onwards, you will not be prompted to match those strokes
anymore.

However, if you need to draw the first star again in subsequent frames, that can be
done by changing the Matching Frame to display Frame 1’s Onionskin Image.
Please refer to Chapter 08 – Onion Skin Panel: Matching Frame.

Auto Stroke Grouping Mode
When enabled, every stroke drawn will be grouped individually. It can be useful when
used together with the Bone Tool.

User Manual
Auto Add Feature Point Mode
When enabled, every stroke drawn will have feature points added to the its ends
automatically. This is useful when trying to change the behavior of the inbetween
animation.
This is an example where the stroke is more complex and has 2 sharp corners.

With the mode enabled, feature point paths are added after the stroke is drawn in
the 2nd key frame.

When generating the inbetween frames, the sharp corners are better maintained.
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Without the mode, the results are not as good.

However, because the feature point paths are automatically generated, in certain
scenarios the results might still require additional adjustments.

(1.x) Undo Previous Action
(1.x) Redo Next Action
Moved to Playback Bar.

User Manual

Stroke Taper Panel
Controlling the width of your strokes allows you to express nuanced details in your
drawings. However, it is not easy for the animator to get consistent results across so
many frames. With the Stroke Taper Panel, you can adjust the width of a stroke as it
starts or ends and how it connects to another stroke.

Start Width Taper
Range (Start)
End Width Taper
Range (End)

Stroke Width Matching Modes
Range
Max Width for Connected Ends
Allow Per Tool Taper Settings

Start Width Taper
Affects the starting width of the stroke. You can enable this option by clicking on the
checkbox.
Range (Start)
Determines how much of the stroke is affected by the Start Width Taper option.
Affects the 1st half of the stroke.

End Width Taper
Affects the ending width of the stroke. You can enable this option by clicking on the
checkbox.
Range (End)
Determines how much of the stroke is affected by the End Width Taper option.
Affects the 2nd half of the stroke.

Stroke Width Matching Modes
These modes allow you to choose what happens when a stroke connects to another
stroke.
No Adaptive Stroke Width Matching
Modes are disabled.
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Entire Stroke
Stroke width matching affects the whole stroke.
Stroke Ends Only
Stroke width matching affects only the ends of a stroke.
Range
Determines how much of the stroke is affected by the Stroke Ends Only mode.
Affects both ends of the stroke. A 50% value means that the stroke width
adjustment will affect up to 50% of the stroke on the connected end.
Max Width for Connected Ends
When enabled, the ends of both connecting strokes will be set to the maximum stroke
width value of the existing stroke. When disabled (default), the ends of both
connecting strokes will be set to the current stroke width value of the existing stroke.
Allow Per Tool Taper Settings
By default (disabled), the settings in the panel will apply to all Drawing Tools, Selection
Tool and Stroke Editor. When enabled, you can configure the taper settings for each
tool.

Using the Stroke Taper Panel
The panel is divided into 2 sections. The 1st section has properties to adjust the
width of unconnected stroke ends, while the 2nd section has properties affecting the
width of connected stroke ends.

You can enable and disable the Stroke Taper Panel from the Panel Display Bar.

User Manual
You can use the stroke taper properties together with the Drawing Tools, Selection
Tool, the Stroke Editor and the Clean Up Tool. To do so, you need to first select any
of the above tools, then configure the properties. This is because each tool can have
different stroke taper properties. Subsequently the tapering effect will work after
the tool is used.

However, the Selection Tool is an exception. To use the stroke tapering with it, first
select the stroke or strokes, then Right Click and select Apply Stroke Tapering.

This is an example of the tapering when different values are set for the Unconnected
Strokes section.

Width Tapering Disabled
Start Width 20% / Range 10%
Start Width 70% / Range 10%
Start Width 20% / Range 50%
Start & End Widths 20% / Range 50%
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In addition to the ends of unconnected strokes, you can adjust how strokes connect
to each other as well.

When either the Entire Stroke or Stroke Ends Only mode is enabled, the connected
stroke end will match the width of the stroke it’s connected to.

The difference between the Entire Stroke and Strokes Ends Only modes can be seen
when drawing a stroke that is connected on both ends. When the Entire Stroke
mode is enabled, the maximum stroke width is determined by either of the
connected ends. When using Stroke Ends Only mode, the maximum stroke width is
determined by the tool’s Stroke Width property.

User Manual
The Max Width for Connected Ends mode is useful when you want to thicken the
stroke width when 2 strokes are connected. The width value is based on the thickest
width value in the existing stroke.

You can also set shortcut keys to enable or disable the options from the keyboard.
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Changing Canvas Settings
Other than drawing tools, there will be times when you need to adjust the
canvas to suit particular scenes. The canvas can be changed by selecting the
Canvas Settings… option in the File menu. In this option, you can adjust the
canvas size, DPI and canvas colors.

Pixel Dimensions: Width and Height
You can manually specify the width and height of the canvas, in pixels.

Print Size: Width, Height and DPI
You can also specify the physical width and height dimensions in centimeters or
inches. There is an additional option, the DPI or Dots per Inch. In CACANi, it is
equivalent to PPI, or Pixels per Inch. This is useful when you have to print out the
images.

Keep Aspect Ratio
When enabled, the Width and Height of the canvas is scaled proportionally whenever
one of the values is changed.
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Preserve Pixels
When enabled, the Print Size Width, Height and DPI will be adjusted automatically to
fit the original pixel dimensions into the defined values. The Keep Aspect Ratio option
will also be enabled automatically. This is useful when you do not want the original
pixel dimensions of the canvas to change.

Conversely, when the option is disabled, changing the DPI value will increase the pixel
dimensions of the canvas.

Fit to Camera
Allows you to assign the camera dimensions as the canvas dimensions as well.

Changing Canvas Colors
Allows you to change the default canvas color to other values. Left Click Twice on
the Color Selection Box to choose a different color. Left Click on the Default button
to reset any color changes.

You can also choose to show the Raster Layer and Sketch Layer canvases with
different colors. If you do not want those layers to have different canvas colors, turn
off the checkboxes.
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CHAPTER 05 – Selecting & Editing Strokes

05
Selecting & Editing
Strokes

User Manual

Refining your Drawings in CACANi
With CACANi’s paperless workflow, we have created tools that will help you produce
animation drawings of utmost finesse. From stroke selection to gap closing to
segment hiding, these editing tools will allow you to prepare the sequence for coloring.

Common Tool Properties
There are a number of tools which share similar property controls. As such, we’ll have
a more thorough explanation when the property is first listed, while subsequent
similar properties will only make references to these descriptions.

Editing Tools
The Editing Tools are used for stroke and image selection and adjustments.
Selection Tool

Stroke Editor

Selection Tool
Allows you to make selections and adjust strokes, groups, and images on the canvas.
Left Click on the element to select it or drag a selection box around multiple elements
to select them.
Hold Down Shift to select multiple elements. Hold Down [Alt] to deselect elements.
After selecting an element, its bounding box will appear.

To move selected elements, Left Click on one of the elements and drag to the desired
location. Left Clicking on the canvas, either within or outside of the bounding box,
clears the selection.
To resize selected elements, Left Click and Drag on one of the bounding box handles.
To resize elements proportionally, Hold Shift while Left Clicking and dragging the
handles.
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To rotate selected elements, Left Click and Drag the green circular handle in a
clockwise or anti-clockwise motion. The elements will be rotated with respect to the
pivot (small red circle). If you want to change the centre of rotation, Left Click and
Drag the pivot to the desired position before rotating.
Multiple Frames Transformation
To move, resize or rotate elements across multiple frames, you will need to select the
desired frames in the Cel Bank.

Selection Tool Properties

1

2

3

1

4

5

6

7

8

9

10

11

12

Selection Modes
Allows you to select strokes using Lasso Selection, Box Selection or Path Selection
Modes.
Lasso Selection Mode
Allows you to select strokes by forming a freeform region around the strokes.
This will select strokes partially within the freeform region as well.
Box Selection Mode
Allows you to select strokes by forming a rectangular region around the
strokes. This will select strokes partially within the rectangular region as well.
Path Selection Mode
Allows you to select strokes by moving your cursor over the strokes. Strokes
touched by the cursor path will be selected.

2

Group Select Mode
When disabled, you can select and edit strokes in groups and masks.
(1.x) Apply to Colored Regions
Updates colored regions whenever strokes are moved, scaled or rotated.
Removed after improvement in stroke connections.

3

Size
Sets the maximum width of selected strokes.

4

Opacity
Sets the opacity / transparency of selected strokes.

User Manual
5

Stroke Color Selection Box
You can set the stroke color by Double Clicking to bring up the Color Selection
Box dialog box. When done, just Left Click OK to confirm.

6

Anchor Point
Allows you to reposition the anchor point for the transformation of selected
elements.

7

Width and Height (Resizing)
Size and Height of the selected elements, in pixels. Change either value by
dragging the slider, or Left Clicking and typing a specific value.

8

Maintain Aspect Ratio
When enabled, changing either the width or height of selected elements will lead
to a corresponding change in the other.

9

X and Y (Translation)
Horizontal and Vertical positions of the centre of the selected elements. A positive
X value Shifts the elements right, whereas a positive Y value Shifts the elements
up.

10

Angle (Rotation)
Rotation angle of the selected elements. A positive value rotates the elements in
the clockwise direction, whereas a negative value rotates the elements in the anticlockwise direction.

11

Stroke Rendering Mode Conversion
Allows you to convert between the different stroke modes.

12

Set Single Pivot (Multiple Frames Only)
When enabled, all selected frames will rotate around a single point on the canvas.
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Selection Tool Context Menu
When you have strokes selected, there are additional functions that you can use.
You can see them when you perform a Right Click in the canvas. There are 2
different context menus: one when nothing is selected and another when the cursor
is over a selection of strokes.

Please see Chapter 03 – Edit Menu and Chapter 03 – Objects Menu for explanation
on the various functions.

Selection Tool (Raster Layer)
You can use the Selection Tool to adjust and transform your drawings in the raster
layer.
Selection Tool Properties (Raster Layer)

1

1

2

3

4

5

6

7

Selection Modes
Allows you to select sections of your drawing using Lasso Selection or Box
Selection Modes.
Lasso Selection Mode
Allows you to select strokes by forming a freeform region around the strokes.
This will select strokes partially within the freeform region as well.
Box Selection Mode
Allows you to select strokes by forming a rectangular region around the
strokes. This will select strokes partially within the rectangular region as well.

User Manual
2

Anchor Point
Allows you to reposition the anchor point for the transformation of selected
elements.

3

Width and Height (Resizing)
Size and Height of the selection, in pixels. Change either value by dragging the
slider or Left Clicking and typing a specific value.

4

Maintain Aspect Ratio
When enabled, changing either the width or height of the selection will lead to a
corresponding change in the other dimension.

5

X and Y (Translation)
Horizontal and Vertical positions of the centre of the selection, in pixels. A positive
X value moves the selection right, whereas a positive Y value moves the selection
frame up.

6

Angle (Rotation)
Rotation angle of the selection. A positive value rotates the selection in the
clockwise direction, whereas a negative value rotates the selection in the anticlockwise direction.

7

Anti-Aliased Transform
When enabled, non-transparent pixels along selection edges are smoothed.

Raster Context Menu
When you have sections of your drawing selected, there are additional functions
that you can use. You can see them when you perform a Right Click in the canvas.
There are 2 different context menus. You will see the first when nothing is selected,
or a selection is made but not cut or copied. The second context menu is available
when a selection is cut or copied.

Please see Chapter 03 – Edit Menu and Chapter 03 – Objects Menu for explanation
on the various functions.
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Selection Tool (Image Layer)
You can use the Selection Tool to adjust and unload images as well.
Loading / Unloading Images
Please see Chapter 07 - Loading Images on how to load external images.
To unload an image, the Image layer in the Cel Bank must be active. Then use the
Selection Tool to click on the image on the canvas. It will be outlined in red. Right Click
to bring up the Context Menu, and then select Remove Selected Images.

Resizing, Rotating, Moving the Image on the Canvas
To adjust an image, the Image layer in the Cel Bank must be active. Then use the
Selection Tool to click on the image on the canvas. It is outlined in red, with
adjustment handles.
To select multiple images, Hold Shift and Left Click on each of the images.
Alternatively, Left Click and Drag the cursor over the images to select them.

To Resize the image(s), Left Click and Drag on any of the 8 handles.
If the Maintain Aspect Ratio option is enabled (in Property bar), dragging on
any of the 4 corner handles will resize the image proportionally.
Alternatively, you can also Hold Shift while dragging the corner handles.
To Rotate the image(s), Left Click and Drag anywhere along the edge of the image.
To Move the image(s), Left Click anywhere within the image and Drag.
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Selection Tool Properties (Image Layer)
When an image is selected, the Selection Tool properties will have different options.

1

2

3

4

5

6

1

Layer Name
Shows the name for the selected layer.

2

Width and Height (Resizing)
Size and Height of the image, in pixels. Change either value by dragging the slider
or Left Clicking and typing a specific value.

3

Maintain Aspect Ratio
When enabled, changing either the width or height of the image will lead to a
corresponding change in the other dimension.

4

X and Y (Translation)
Horizontal and Vertical positions of the centre of the image, in pixels. A positive X
value moves the image right, whereas a positive Y value moves the image frame
up.

5

Angle (Rotation)
Rotation angle of the image. A positive value rotates the image in the clockwise
direction, whereas a negative value rotates the image in the anti-clockwise
direction.

6

Reset
The translation, scaling and rotation values of the image are reverted to their
original values.

Image Context Menu
You can bring up the context menu by Right Clicking on an image in the canvas.

User Manual
Please see Chapter 03 – Edit Menu and Chapter 03 – Objects Menu for explanation
on the various functions.

Selection Tool (Video Layer)
Right after loading a video file, CACANi will switch to the Selection Tool so that you
can adjust and transform the video on the canvas. When you Left Click outside of
the video and change a tool, there will be a dialog to confirm the adjustments. After
the confirmation, you can edit and transform sections of the video like a drawing on
a raster layer.

Selection Tool Properties (Video Layer)

Please see Chapter 05 – Selection Tool Properties (Raster Layer).

Video Context Menu

Please see Chapter 03 – Edit Menu and Chapter 03 – Objects Menu for explanation
on the various functions.
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Using Video Reference
A video reference is different from a video in a video layer. A video reference works
like a standalone video player in the canvas, while a video is loaded as video frames
in a video layer and is synchronized with other layers in the Cel Bank.
You can add a Video Reference using the Selection Tool. Right Click to bring up the
context menu.

Select the video and you will see it loaded on the canvas. No video layer is created in
the Cel Bank.

You can move and scale the video on the canvas. You can play the video using the
frames slider or using keyboard shortcuts.

User Manual
To remove the video reference, Right Click on the video and select Delete.
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Stroke Editor
Allows you to edit data points on a stroke to adjust its path. To do so, move the cursor
over the stroke to highlight it. To change the path of a stroke, Left Click and Drag on
a data point.

To add a data point, Hold Alt and Left Click on any part of the stroke that does not
already have a data point. This creates a new data point.

To remove a data point, Hold Alt and Left Click on any existing data point. The
selected data point is removed.

Stroke Editor Context Menu
Alternatively, you can access stroke editing options via the context menu.
Hover over any part of the stroke without a data point and Right Click to bring up the
context menu. Select Add Point to create a new data point.

User Manual
To remove data points, hover over a data point and Right Click to bring up the context
menu. Select the Remove Point option.

A stroke can also be separated into 2 strokes by selecting the Cut Stroke option from
the context menu. This option can be found in both context menus.

Stroke Editor Properties

1

1

2

3

Stroke Edit Modes
When adjusting strokes with Smooth Edit mode selected, smoothness within the
segments of a stroke is maintained. You can adjust the path of the stroke by Left
Clicking and dragging the data points (green points) and end points (red and blue
point). The selected stroke will be highlighted in red, and the selected point will
be displayed as an orange dot.

When adjusting strokes with Control Point Edit mode selected, segments of a
stroke can be either continuous or discontinuous. The control points (purple
points) of a selected data point and its adjacent data points are displayed. When
editing, only the segment around the selected data point will be affected.

When moving data points, stroke path is continuous.
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To create sharp corners in the stroke, Hold Ctrl while dragging the control points.
The stroke is now discontinuous.

After the stroke is made discontinuous, the sharp corner will be maintained, even
when moving the point.

However, moving a control point for a sharp corner will cause the discontinuous
segment to be automatically re-adjusted into a continuous segment.

To maintain the sharp corner while moving the control point, Hold Down Ctrl.

User Manual
When Fixed Ends mode is selected, only the 2 end points of a stroke can be
selected. When you select and drag one end point, the other end point will be
fixed and will act like a pivot. The stroke then can be rotated or resized according
to this pivot.

Influence
Controls how many adjacent points are affected by a data point adjustment in the
stroke. With a higher influence, the movement of adjacent points will become
larger. At 0% influence, the adjacent data points are not affected.

Influence 10%
Influence 0%

Auto Select Stroke
When enabled, a stroke remains selected during the editing of its points, or when
the cursor hovers away from it.
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Animation Editing Tools
The Animation Editing Tools are used when you need to adjust the generated strokes
in the in-between frames.

Bone Tool

Feature Point
Tool

Feature Point Tool
Allows you to adjust the deformation of a generated stroke in an in-between frame.
Please see Chapter 08 – Using the Feature Point Tool for more information.
Feature Point Tool Properties

1

2

3

4

5

6

7

1

Remove All Feature Points
Allows you to clear all feature points on the selected stroke.

2

Auto Add Feature Points for Stroke
Automatically creates matching feature points for the start, end and sharp
corners in a selected stroke in the current and next key frames.

3

Auto Add Feature Points for All Strokes
Automatically creates matching feature points for the start, end and sharp
corners in all strokes in the current and next key frames.

4

Match All Feature Points
CACANi will try to link all feature points in both key frames, even when the stroke
segment does not look the same. For example, a sharp corner will be matched to
a straight segment.

5

Update All Feature Point Paths
Except for feature point paths on the starting and ending of a stroke, all feature
point paths will be adjusted at once on the selected stroke.

User Manual
6

Force Same Direction
When enabled, all feature point paths will bend in a similar direction and
curvature to the adjusted path. To use this, Update All Feature Point Paths
property needs to be enabled.

7

Hair
When there are unequal number of hair-like spikes in a stroke in a pair of key
frames, this property will help make those spikes appear or disappear into
another segment of the stroke.

Bone Tool
Allows you to change the way strokes are generated in a group in an in-between frame.
Please see Chapter 08 – Using the Bone Tool for more information.
Bone Tool Properties

1

2

3

4

5

6

7

1

Remove Bone
Allows you to clear the paths for the selected stroke group.

2

Points
Defines the number of points present on the created path.

3

Maintain Bone Length
When enabled, the paths for a stroke group will be constrained by the length of
the drawn bones in the key frames.

4

Lock Path
When enabled, the path is kept selected and can be edited more easily.

5

Stroke Edit Modes
Allows you to edit data points on a stroke to adjust the paths of the stroke groups.
Please see Chapter 05 – Stroke Editor Properties – Stroke Edit Modes for more
information.
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Bone Rotation Paths
Allows you to change how the paths are generated based on the angle of rotation.
Direct Rotation Path
The in-between frames for the stroke group are generated based on an angle
of rotation less than 180°.

Reverse Rotation Path
The in-between frames for the stroke group are generated based on an angle
of rotation larger than 180° but smaller than 360°.

Over 360° Rotation Path
The in-between frames for the stroke group are generated based on an angle
of rotation larger than 360° but smaller than 540°.

7

Remove All Paths
Deletes bone paths of all stroke groups in the active frame and cel.

User Manual
Bone Tool Context Menu
Other than the Bone Tool properties, you can bring up the Bone Tool’s context menu
when you Right Click on a bone path.

Add Point
Allows you to add points to a bone path for editing.
Copy Path / Paste Path
Allows you to replicate the selected bone path to another group of strokes in
the same or a different layer.
Remove Paths from Selected Groups
Deletes both bone paths from the selected groups of strokes.
Remove All Paths
Deletes bone paths of all stroke groups in the active frame and cel.
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Segment Editing Tools
The Segment Editing Tools are used for cleaning up and adjusting the look of the
strokes. They are also very important for ensuring that the drawings are ready for
painting. However, the tools do not affect the curvature of the strokes.

Segment Tool

Free Segment Tool

Clean up Tool

Stroke Size Tool

Segment Tool
Allows you to alter the visibility of sections of a stroke, where the sections are created
by intersections with other strokes.

Segment Tool Properties

1

2

3

1

Size
Allows you to increase the selection area when changing the segment rendering.
This property is only applicable in the Click Selection Mode.

2

Stroke Rendering Modes
Allows you to change a stroke segment into one with Normal, Invisible or Hidden
properties.
Please refer to Chapter 04 – Stroke Rendering Modes.

User Manual
3

Segment Selection Modes
You can select segments using either the Click Selection, Line Selection or Lasso
Selection modes.
Click Selection
Click on a stroke segment to change its property.
Line Selection
Draw a line across stroke segments to change their properties.
Lasso Selection
Draw a region around stroke segments to change their properties.

Free Segment Tool
Allows you to alter the visibility of sections of a stroke, regardless of any intersections
with other strokes.

Free Segment Properties

1

2

1

Size
Allows you to increase the selection area when changing the segment rendering.

2

Stroke Rendering Modes
Allows you to change a stroke segment into one with Normal, Invisible or Hidden
properties.
Please refer to Chapter 04 – Stroke Rendering Modes.
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Clean Up Tool
Allows you to edit how strokes are attached to each other to form closed regions for
painting. The Clean Up Tool can perform 2 different functions, depending on how the
strokes are selected or lasso-ed.

Gap Closing
At least 1 stroke end must be within the selected region for the tool to work.

Segment Removal
Allows you to remove stroke segments, or unwanted stray ends, during the drawing
process. Stroke segments falling within the threshold region are removed.

Clean Up Modes
The Combined Mode will either do gap closing or segment removing based on the
selected stroke ends and intersections.

User Manual
You can lasso a lot more stroke ends, but depending on the complexity and proximity
of the selected strokes, results will vary.

The other 2 modes, Gap Close Only and Segment Removal Only, as their names
suggest, limits the Clean Up Tool to only perform gap closing or segment removing
respectively. This can help with certain situations where there are many intersecting
strokes.
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Clean Up Tool Properties

1

2

3

4

5

6

7

8

1

Clean Up Modes
Allows you to specify whether the tool works in Combined, Gap Close Only or
Segment Removal Only Mode.

2

Gap Selection Modes
Allows you to close gaps in different ways.
Lasso, Variable Gap Size
Closes a gap as long as the end of a stroke and a target stroke segment are
both selected in the lasso region. The gap size slider is not applicable in this
mode. This is the original mode in CACANi 1.x.

Lasso, Fixed Gap Size
Closes a gap when the end of a stroke and a target stroke segment are within
the gap indicator region.

Region Gap Close
Closes gaps around a region. The gap size is set when the user clicks and drag
within a region.

User Manual
3

Gap Size
Sets the gap close or segment removal threshold region for the Apply to All
Strokes option. A larger value results in wider stroke gaps closed or longer stroke
segments removed.

4

All Strokes
Allows you to close all stroke gaps and remove all segments in the drawing that
are within the region defined in the Size property. However, some strokes may be
altered in an undesirable way.

5

Keep Gaps Invisible
When enabled, any gaps closed using the Clean Up Tool are performed with
invisible strokes so that the strokes do not appear to be altered.

6

Straight Extensions
When disabled, stroke ends within the lasso threshold size / circle will be
extended to connect to each other, regardless of the strokes’ directions.

Also, using different threshold sizes will result in different stroke extensions, as
the circumference of the threshold determines where the connection point is.
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When enabled, the stroke ends will be extended and connected to each other.
The lasso size does not affect the result.

7

Adjust Stroke Ends When Closing
Shifts stroke ends when performing gap closing. This helps prevent a ‘step-ladder’
extension effect. The property is only available when the Lasso, Fixed Gap Size, or
the Region Gap Close mode is selected.

Disabled

8

Enabled

Reveal Hidden Segments
Allows you to convert hidden segments back to visible segments, without having
to switch to the Segment or Free Segment Tools. This is helpful when regions are
not closed due to hidden segments.

User Manual
Stroke Width Tool
Allows you to change the stroke width at different segments of a stroke. You can
adjust the stroke width by Left Clicking on any of the data points or endpoints, and
dragging the mouse left (decrease stroke width) or right (increase stroke width).

Stroke Width Tool Properties

1

2

1

Size
Sets the maximum width of selected strokes.

2

Range
Sets the number of adjacent data points that are affected by the stroke width
change. Note that after the width adjustment, you will also need to move the data
point slightly with the Stroke Editor to get a smooth width transition.
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Displaying Information on the Canvas

While drawing, animators frequently need to see information about their drawings,
from camera frames to measurement grid and stroke gaps. However, it can be very
messy when all the information is switched on at the same time. In CACANi, these
display modes are arranged at the top of the interface so that they can be activated
when needed.

Display Property Bar
The Display Property Bar is divided into a few sections.

Canvas Display Modes

Onion Skin Image Display Modes

Stroke Display Modes

Region Display Modes

Canvas Display Options

The canvas shows various information to help you with the animation process. You
can turn them on or off here.
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Show Camera Frame
When enabled, it allows you to see the camera frame (solid line) on the canvas. The
video safe frame is the dotted line within the camera boundary.

Show Crosshairs
Divides the camera into 4 sections, which can help with the layout of the animation
drawings. Show Camera Frame needs to be enabled.

Show Field Chart
Allows you to display an animation field chart within the camera. This will help with
the planning and layout of drawings within the canvas.

User Manual
Show Animation Details and Peg Holes
Displays the Scene or Cut Number, Description and Duration of the current file. Also
displays the traditional peg holes found on animation paper.

The animation details can be entered via the Animation Information… option in the
File menu, or from the Camera Tool, Enter Animation Information option.

Show Grid
Allows you to display a rectangular grid over the canvas. This will help with the
planning and layout of drawings within the canvas.
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Show Status
Displays various details about the current state of the CACANi software and the
opened file.

‘Always Update Region Colors’ mode – When enabled, CACANi will
constantly recheck the regions after every user interaction. Gives faster
updates of colored regions and location of gaps, but drawings with many
vector strokes will slow down the canvas refresh rate.
Memory – memory used by the CACANi software.
FPS – Refresh rate of the canvas, measured in Frames per Second. A useful
numerical indicator of the responsiveness, or choppiness, of the canvas.
Generally, the more vector strokes there are, or the larger the canvas in a
drawing, the lower the FPS.
Intersections – Counts the number of connections between vector strokes.
The more connections there are, the less responsive the canvas.
Poly Count – Shows the number of triangle faces of the vector strokes, when
stroke width is enabled. The higher the poly count, the less responsive the
canvas.

Switch to Small Cursor
When enabled, cursor is rendered in software as a simple square and cursor icons will
not be displayed. When disabled, the cursor is rendered using OpenGL and will change
depending on the stroke width and tools selected. If you find that the cursor is lagging,
enabling this may help. It is disabled by default.

User Manual

Stroke Display Options

The Stroke Display Options section has some buttons allowing you to select
frequently used options and a dropdown menu listing all the options.

Show Stroke Width
When enabled, the actual stroke width is displayed. When disabled, the Stroke
Skeleton is shown, for more accurate drawing.

In addition, the stroke centerline can be thickened using the Stroke Skeleton slider for
easier viewing. In CACANi 2.0, this option is renamed ‘Change Centerline Display…’
and has been moved to the View menu.
CACANi 1.x

CACANi 2.x (View menu)
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Show Strokes’ Directions
When enabled, strokes selected with the Selection tool will have arrows displayed on
them. These arrows indicate the direction in which the stroke was drawn and will
allow you to draw matching strokes in subsequent frames correctly.

Show Gaps
When enabled, stroke ends that are not connected to any other stroke will be
indicated with a light orange circle.

User Manual
Show Invisible / Hidden Strokes
When enabled, invisible and hidden strokes are displayed in the canvas in orange and
purple respectively.

Show Color Separation Strokes
When enabled, strokes selected with the Selection tool will have arrows displayed on
them. These arrows indicate the direction in which the stroke was drawn and will
allow you to draw matching strokes in subsequent frames correctly.

Lighten Strokes in Inactive Layers
When enabled, strokes on unselected layers will be faded out. By only showing
specific sections of a drawing, this can help you to focus on those areas and not be
confused.
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Switch Hidden Stroke View
Fades out normal strokes, while invisible and hidden strokes are bolded. This helps
you to see and draw those strokes easily.

Show Layer Tag Colors on Strokes
Displays stroke colors based on their layer color tags.

Show Intersection and End Points
Indicates intersection points between strokes as well as the end points of each stroke.
Mainly used for troubleshooting purposes.

User Manual
Auto Update Occluded Strokes
Refreshes the visibility of occluded strokes immediately when boundary strokes are
edited. When disabled, you can use the Update Selected Occluded Strokes option to
update the visibility manually.

Show Stroke Index during Cursor Hover
Displays the index of a stroke when the cursor hovers above them.

Apply Anti-Aliasing in Strokes
Enables edge smoothening to vector strokes. Applies to strokes in Drawing and
Sketch Layers.
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Region Display Options

Show Region Colors
When enabled, all filled regions are displayed in their original
colors.

Hide Region Colors
When enabled, no region colors are displayed.

Highlight Self Regions
When enabled, all Single Layer regions will be displayed with
checkered patterns.

Show Closed Regions
All closed regions without any gaps will be painted in alternating
colors. Use it to check for gaps before painting the regions.

Show Closed Self Regions
All single layer regions that are closed and do not have any gaps,
are painted in alternating colors with checkered patterns.

Show Painted Regions
All regions filled with color are painted in black. This is useful when
verifying that you have not missed any regions that require
painting.
Please see Chapter 10 - Cross Layer and Single Layer Regions for more information
on regions.

Always Update Region Colors
When enabled, region colors are updated immediately after each drawing or editing
operation. This is useful for quick feedback as you draw your animation. However,
for drawings with thousands of strokes, this can slow down the computer.

User Manual

Onion Skin Display Options
Displays drawings from previous or subsequent frames on the canvas as onionskinned images.

Please see Chapter 08 – Onion Skin Settings.
Please see Chapter 08 – Onion Skin Panel for more information on configuring onionskinned images.
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The Cel System
Cel Selection Bar

Frame Control

Layer Selection Bar

Cel Bank

The Cel System is used for the management of layers and frames for animation. Cels,
Layers and different types of frames can be added or removed, their orders changed
and management for drawing and animation.
Cel Selection Bar
Allows you to access cels and adjust various cel-related settings easily.
Layer Selection Bar
Allows you to access layers and adjust various layer-related settings easily.
Frame Controls
Allows you to create or remove cels, layers or frames.
Cel Bank
Allows you to perform all cel, layer and frame operations.
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Cel Bank

In CACANi, the Cel Bank is the main location for frames, layers and cels creation and
editing, while the Cel / Layer Selection Bars and Cel Control Bar provide
supplementary support.
While the Cel Bank is a panel that can be moved around, docked or hidden from view,
the Cel Selection Bar, Layer Selection Bar and Cel Control Bar are fixed on the user
interface for ease of use.

Sections of the Cel Bank

Cel View

Frame View

The Cel Bank consists of 2 distinct components, the Cel View section and the Frame
View section.
The Cel View shows the cel / layer names and allows you to perform cel / layer
operations, while the Frame View shows the frames and contains the frame
operations.

User Manual
Cel View
Elapsed Time

Active Layer

Expand / Collapse
Cel

Expand / Collapse
Frame View

Color Tag

Layer Visibility
Layer Lock
Layer Onion Skin
Cel View Scrollbar
Opacity Slider

Layer Name

Elapsed Time
Shows the time at the active frame, in ( Minutes : Seconds : Frames ) format.
Active Layer
Lists the current selected cel or layer.
Expand / Collapse Cel
Reveals or hides the layers within a cel.
Color Tag
Displays the color tag of a layer.
Opacity Slider
Allows you to adjust the opacity level of a cel or layer.
Layer Name
Displays the cel or layer.
Expand / Collapse Frame View
Reveals or hides the Frame View section of the Cel Bank.
Layer Visibility
When enabled, the contents of the layer are displayed.
Layer Lock
When enabled, the strokes in the layer are locked and cannot be changed.

01 02 03 04 05 06 07 08 09 10 11
Animating & In-betweening

| CACANi

Layer Onion Skin
When enabled, the strokes in the layer are included when displaying the frame as
an onionskin image.
Cel View Scrollbar
Allows you to pan vertically through the created cels and layers.

Frame View
Frame View Scrollbar

Offpeg Onionskin Marker

Playback Range
Range ‘Out’ Point

Range ‘In’ Point

Frame Number
Onionskin Marker

Cel Frame Number

Playhead

Active Frame

Frame View Scrollbar
Allows you to pan horizontally through frames and sheets.
Offpeg Onionskin Marker
When enabled, an onionskin image of the current frame is displayed on the canvas,
independent of the active frame.
Playback Range
Indicates the frames that will be played back when the Playback Range checkbox
is ticked in the Playback Bar.
Range ‘In’ Point
Allows you to adjust the starting frame of the Playback Range.
Range ‘Out’ Point
Allows you to adjust the ending frame of the Playback Range.
Onionskin Marker
When enabled, an onionskin image of the current frame is displayed on the canvas.
Unlike the Offpeg Onionskin, this is always in relation to the active frame.

User Manual
Playhead
Indicates the location of the active frame. You can drag the Playhead to make
another frame active.
Active Frame
Indicates the current selected frame in the cel bank.
Frame Number
Indicates the frame number of the overall animation sequence.
Cel Frame Number
Indicates the frame number of the specific cel.

Frames, Layers, Cels
The distinction between cels, layers and frames is important to the understanding of
CACANi’s system of animation. With this knowledge, you will be able to make use of
CACANi’s unique workflow to create your animations quickly.
Frame

Layer
Cel

Frames
A frame can consist of a drawing in a single layer or be made up of a column of
drawings in multiple layers. A frame is what you see displayed on the canvas.
Layers
A layer is a single sequence, or row, of frames. There are different types of layers
available, each with its own purpose. Layers within the same cel have the same
number of frames and frame types.
Cels
A cel is a master layer that can hold multiple layers. Cels can have different number
of frames from each other.
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Frame Types
In CACANi, there are 4 types of frames, Key Frames, In-between Frames, Hold Frames
and Repeat Frames.

Hold Frame
Repeat Frame
Key Frame

In-between Frame

Key Frames
Frames that hold drawings created by the animator. They are normally at the
beginning and ending part of an animation sequence. Key frames are denoted with a
dash beneath the stroke numbers.
In-between Frames
Transition frames that are generated based on the key frames. Information between
matching strokes in a pair of key frames is used to create in-between frames. Inbetween frames do not have any marking beneath the stroke numbers and are
colored a darker shade of gray compared to key frames.
Note that multiple layers within a cel form a frame.
Hold Frames
Extends the duration of the previous Frame. Use them when you need to show a
drawing for a longer time.
Repeat Frames
Mirrors the drawing in another Frame. Unlike duplicating a frame, a repeat frame
will be updated whenever the original frame is changed. Repeat Frames can also be
placed anywhere in the cel. Left Click Twice on a hold frame to convert it to a repeat
frame.
Onion Skin Frames, Offpeg Frames
In addition, to help you visualize drawings from other frames, we have Onion Skin
Frames and Offpeg Frames, or Onion Skin Images and Offpeg Images.
These are covered in Chapter 08 - Onion Skin Panel.

User Manual
Frame Type Conversion
You can turn a key frame into an in-between frame, and vice versa. This can help you
to perform adjustments on the animation sequence, or as a way to create breakdown
key frames.
To perform this action, Right Click on a frame to bring up the context menu. Since this
frame is a key frame, select Convert to Inbetween Frames to convert into an inbetween frame.

Alternatively, you can also select the options from the Frames main menu.
Other than converting between key and in-between frames, you can select other
types of frames.
Convert to Key Frames
Changes the selected frames into key frames.
Convert to Empty Key Frames
Deletes the contents of the selected frames before changing them into key
frames.
Convert to Inbetween Frames
Changes the selected frames into in-between frames.
Convert to Empty Inbetween Frames
Deletes the contents of the selected frames before changing them into inbetween frames.
Convert to Hold Frames
Changes the selected frames into hold frames. The original contents of the frames
are deleted.
However, you have to be careful when converting key frames into in-between frames,
in that you do not accidentally re-generate in-between frames. This may cause the
strokes in the newly converted in-between frame to change. Or erase a drawing by
turning a frame into an empty key frame.
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Layer Types
There are different types of layers to help you animate in CACANi. Each type is colored
differently and has a specific use. You can access them from both the Cel Bank and
the Layer Selection Bar.
Audio layer
Video layer
Image layer
Color Separation Layer
Sketch Layer
Raster Layer
Drawing Layer

Drawing Layer
Most frequently used layer type. You can draw, trace, animate and paint your
drawings here. Strokes and regions are vector-based.
Sketch Layer
Used for roughing out your animations. Sketch layers do not have animation
capabilities. In addition, you cannot paint regions formed by strokes in Sketch layers.
Like Drawing Layers, strokes in the Sketch Layer are vector-based.
Raster Layer
Used for drawing draft or finished animations. Raster layers do not have automatic inbetweening capabilities. Strokes and regions in raster layers are bitmap / pixel-based.
Please see Chapter 04 – Pen Tool Properties (Raster Layer) for more information.
Color Separation Layers
Used for drawing color separation strokes. When Color Separation Display Mode is
turned off, the strokes in these layers do not show up on the canvas or the exported
images. Strokes and regions are vector-based.
There are 6 different color separation layers: Red, Green, Blue, Cyan, Pink, Yellow.
Please see Chapter 05 – Color Separation Strokes for more information.
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Image Layer
Used for loading external image files into the Cel Bank. Loaded images can be moved
and manipulated using the Selection Tool. No drawing or animation can be done on
this layer.
Please see Chapter 07 – Working with Images for more information.
Video Layer
Used for loading external video files into the Cel Bank. You can move and manipulate
the video right after loading it, but after confirming the changes, you will not be able
to manipulate the video anymore. After placing and video, you can draw, erase, paint
and edit each video frame, like a raster layer.
Please see Chapter 07 – Working with Video Files for more information.
Audio Layer
Used for loading external audio files into the Cel Bank. You can hear the audio with
the Play button, or scrub through the audio file by dragging the Playhead.
Please see Chapter 07 – Working with Audio Files for more information.

Layer Type Conversion
In CACANi 2.0, each layer type has their own strengths and weaknesses. For example,
the drawing experience in raster layers is closer to pencil and paper, while working
with vector strokes in drawing layers is like making a technical illustration. Each layer
type is useful for different stages of animation production. At the same time, you can
also take advantage of these functions below to bridge the different stages.

Rasterize Image Layer
Converts the image layer into the raster layer. You can use this option to turn external
images into the CACANi raster format, or the raster layer, for further editing.
Extract Line Art…
Allows you to extract line art from drawings and turn the background transparent.
You can use this option on Raster Layers only. For best results, images should be of
high resolutions, with distinct strokes and regions.
Vectorize Layer…
Converts Raster or Image Layers into Drawing Layers. Allows you to convert the raster
drawings into vector strokes. Raster region colors are not supported.
Please see Chapter 07 – Image Rasterization and Vectorization for more information.
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Using the Cel Bank – Cel View
This is where you can perform layer / cel creation and selection operations, as well as
amend various layer statuses.

Layer / Cel Creation
You can create a new layer by Right Clicking on a cel, layer, or the empty space below
the layers and choosing either of the New ... Layers options from the dropdown menu.

Layer Name Change
You can rename a layer by Double Clicking on the name. A dialog box will pop up and
the new name can be entered.

Layer Selection
When working in CACANi, there are various methods you can use to select layers:
Single Layer
A single layer can be selected easily by Left Clicking directly on the specific layer. The
layer will be highlighted.
Multiple Layers in Sequential Order
When you need to select layers arranged in sequence, start by Left Clicking on the
first or last layer of the sequence. Then, Hold Shift and Left Click to select the layer
on the other end of the sequence.
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Multiple Layers in Non-sequential Order
When you need to select layers arranged arbitrarily, start by Left Clicking on any layer
you wish to select it. Next, Hold Ctrl and Left Click on another layer you wish to include
in your selection.
Layer Types
As there are different types of layers, you can use Select Similar Layer Type to only
pick layers that are of the same type as the current active layer. This can be used to
quickly change layer statuses for multiple layers. Conversely, you can choose Select
All Other Layer Types to pick layers that are not of the same type as the current active
layer.

Layer Selection - Color Tags
In addition to Layer Types, you can also assign Color Tags to specific layers, so that
you can select them easily later. All layers are assigned the Orange Tag by default. To
select layers with the same Color Tag, you can Right Click on the Orange square on a
layer to bring up the dropdown menu and choose Select Similar Color Tag.
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To assign a new Color Tag, first select the required layers (Shift + Left Click or Ctrl +
Left Click).
Then, Right Click on the Orange square on the layer and choose a different Color Tag
from the dropdown menu.

Moving Layers / Cels (Display Order)
You can adjust the order of the layers or cels so that the contents of a layer are
displayed above or below the rest. However, in order to help you minimize any
accidental movements of layers, you need to Hold Left Click on a layer for half a
second before you can move it. After that, you will see the cursor icon change to a
hand icon. Drag the layer to reposition it. A red line will appear to indicate where the
new position of the layer will be.

Layer 2

Layer 1

Hold for
0.5 sec!
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Layer Duplication
You can clone an active layer by Right Clicking and choosing Duplicate Active Layer
from the dropdown menu.

Layer Removal
You can delete a selected layer or cel by Right Clicking and choosing Remove Layer or
Remove Cel from the dropdown menu. In addition, multiple layers or cels can be
deleted at the same time by using Shift + Left Click (for layers / cels arranged in
sequence) or Ctrl + Left Click (for layers / cels arranged arbitrarily) to select the
required layers.

Layer Opacity Slider
You can adjust the opacity, or transparency, of a layer via the Layer Opacity Slider.
Left Click and Drag on the slider to vary the opacity level.
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Layer / Cel Status Toggle
You can change the status of a layer or cel in the Cel View by enabling / disabling the
icon directly.
The Visibility icon displays or hides the contents of the selected layer.

The Lock icon, when toggled, prevents the contents of the selected layer from being
changed. The cursor icon will change to reflect the locked status of the active layer.

The Layer Onion Skin icon, when toggled, includes the strokes of the selected layer
when the frame is displayed as an onionskin image. Note that the onionskin image
will only be displayed when the Show Onion Skin Images option in the Display Bar is
enabled as well.

User Manual
To change a similar status for multiple layers / cels at the same, you can first select
multiple layers / cels (Shift + Left Click Drag or Ctrl + Left Click), then Left Click on the
relevant status icon for one of the selected layers.

Working with Images
You can load images into image layers in a few ways.
Loading a single image to the Image layer
To load an image file as an image, Right Click on any frame in the Cel Bank, then select
Load Image(s) from the context menu.

Choose an image file from the File Explorer Dialog. A new Image layer will be created
with the selected image in the same cel, indicated with a diagonal line over the
reference sheet.
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Alternatively, you can start by first creating the image layer, then Double Clicking on
a particular frame to bring up the image loading dialog window.

Loading multiple images to the Image layer
Using the same Load Image(s) option or Double Clicking on an image layer frame, you
can also select multiple, non-sequential image files to bring into the Cel Bank.

Loading an image sequence to the Image layer
Alternatively, you can select Load Image Sequence to load a series of pictures
numbered sequentially into CACANi.

User Manual
You only need to choose the first file for the sequence. CACANi will warn you that it
will be increasing the number of created frames and possibly replacing images loaded
previously. Click OK to continue.

For the above to work correctly, all the files in the image sequence should have
filenames that end with a numeric value (ie. file001, file002, file003…..).

Clearing images from the Image layer
To clear an image, Right Click on the frame in the Cel Bank, then select Clear Image
from the context menu. The diagonal line indicator will disappear from the reference
sheet as well.

To clear multiple images that are arranged sequentially, you can use Hold Left Click
+ Drag or Shift + Hold Left Click to first select the reference sheets, then Right Click
and select Clear Image(s) from the context menu.
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To clear multiple images that are not arranged sequentially, you can use Ctrl + Hold
Left Click to first select the reference sheets, then Right Click and select Clear Image(s)
from the context menu.

Alternatively, you can use the Selection Tool to click on the image on the canvas. It
will be outlined in red. Right Click to bring up the Context Menu, and then select
Delete.

Resizing, Rotating, Moving the Image on the Canvas
To adjust an image, the Image layer in the Cel Bank must be active. Then use the
Selection Tool to click on the image on the canvas. It is outlined in red, with
adjustment handles.
To select multiple images, Hold Shift and Left Click on each of the images.
Alternatively, Left Click and Drag the cursor over the images to select them.

To Resize the image(s), Left Click and Drag on any of the 8 handles.
If the Maintain Aspect Ratio option is enabled (in Property bar), dragging on
any of the 4 corner handles will resize the image proportionally.
Alternatively you can Hold Shift while dragging the corner handles.
To Rotate the image(s), Hold Left Click and Drag anywhere along the edge of the
image.
To Move the image(s), Hold Left Click anywhere within the image and Drag.
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Working with Video Files
Loading video files
You can load video files into CACANi in a few ways. Select the Import Video… option
from the File menu. Select a video to load. CACANi supports AVI, MP4 and WMV
formats.

A video layer is created and the video is imported onto the canvas.

Alternatively, you can load the video from the Cel Bank. First create an empty video
layer from the Cel View, then click on the canvas to bring up the load video dialog
window.
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Or you can Right Click on a frame to bring up the context menu in the Frame View.
The chosen video will then be loaded into a new video layer.

After the video is loaded, the Selection Tool is automatically chosen so that you can
adjust it on the canvas. by using the blue handlebars around the video frame.

Resizing, Rotating, Moving the Video on the Canvas
Use the Selection Tool to click on the video on the canvas. It is outlined in blue, with
adjustment handles.
To Resize the video, Hold Left Click and Drag on any of the 8 handles.
Dragging on any of the 4 corner handles will resize the video proportionally.
Alternatively you can Hold Shift while dragging the corner handles.
To Rotate the video, Hold Left Click and Drag anywhere along the edge of the video.
To Move the video, Hold Left Click anywhere within the video and Drag.
You can only adjust the video right after it is loaded. You will need to finalize the
adjustments. Other than scrubbing the playhead to preview the animation, clicking
anywhere else will bring up the confirmation dialog. After confirmation, the video’s
location, size and orientation is fixed on the canvas.
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External Video Link and Saving
Although the video is loaded onto the canvas, it is not saved into the .cacs work file
yet. It maintains its link to the original video file. Deleting or moving the external
video file will break the link. When that happens, the video will not be viewable from
the canvas. In such a situation, you can hover over the video layer to see the folder
path to the missing video.

Editing the Video
Using the Selection Tool, Pen Tool or Eraser, you can edit the loaded video frames.
Please note that when a video frame is edited, the frame’s link with the original
video is broken and the edited frame is now saved in the .cacs work file. On the Cel
Bank, the video frame will be marked with a different color.

With the Selection Tool, you can cut, copy and paste portions of the video.

You can also draw and erase on the video frame using the Pen Tool and Eraser
respectively. They work similar to the Pen Tool and Eraser on Raster Layers.
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Please see Chapter 04 – Pen Tool Properties (Raster Layer).

Working with Audio Files
You can load audio files into CACANi by creating an Audio Layer. Right Click on the
Cel View to bring up the context menu and select New Audio Layer.

Right Click on the Frame View section to bring up the context menu and select Add
Audio File.

User Manual
Changing the Playback Framerate does not affect the audio playback, but it will
change the duration of the animation sequence.

In the Cel View, you can adjust the volume or mute it completely.
Volume Slider

Mute Button

To delete the audio file, Right Click above the waveform and select Remove Audio
File.

External Audio Link and Saving
Although the audio file is loaded onto the canvas, it is not saved into the .cacs work
file yet. It maintains its link to the original audio file. Deleting or moving the external
audio file will break the link. When that happens, the audio cannot be played from
CACANi. A message will appear when the audio file was, showing you the last known
location and name of the audio file.

01 02 03 04 05 06 07 08 09 10 11
Animating & In-betweening

| CACANi

Rasterize Image Layer
This will convert all the images loaded in the layer into editable raster pixels in CACANi.
Right Click on the image layer to bring up the option.

After rasterization, the links to the external image files are still maintained. When the
Selection Tool, Pen Tool or Eraser is used to edit a frame, the link will then be broken
and the frame will be saved in CACANi.

User Manual
Extract Line Art…
By extracting the line art from drawings and turning the background transparent, it is
easier for you to edit them. You can use this option on Raster Layers only. For best
results, images should be of high resolutions, with distinct strokes and regions.
Extracted strokes have aliased, non-smoothed edges.

Preview Mode
Allows you to see the results of the various settings in the canvas. When preview
mode is enabled, the canvas background color is temporarily changed to pale green.
Sharpness
Controls the reproduction of details. Lower values will create thicker strokes at
the expense of details.
Despeckle
Removes small, isolated pixels from the drawings. Higher values will cause larger
areas of pixels to be removed.

Black Stroke Properties
Brightness
Affects the thickness of the black strokes. Higher values reduce the stroke
thickness.
Color Range
Affects the range of colors that are converted to black pixels. Higher values mean
less colors are converted to black pixels.
White Removal
Affects the range of colors considered as the blank paper pixels and hence be
removed. Higher values mean more colors will be considered as blank paper pixels.
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Color Stroke Properties
Brightness
Affects the thickness of the color strokes. Higher values reduce the stroke
thickness.
Color Range
Affects the range of colors that are considered as the specified color. Higher
values mean a greater range of colors are converted to the specified color.
Width
Affects the range of pixels with similar saturation levels as the specified color.
Higher values mean that pixels with a larger variation of saturation are converted
to the specified color and the stroke width is increased.

New Stroke Color
Allows you to extract an additional stroke color from the raster image. A total of
6 stroke colors can be added.
Apply to All Frames
Processes the frames based on the settings in the panel. When the processing is
complete, each extracted color stroke is organized into its own sublayer so that
you can edit them separately.

User Manual
Using Extract Line Art
Right Click on the Image Layer to bring up the context menu then select the Extract
Line Art… option.

Click on the Preview button. The canvas will turn green to signify that CACANi is in
preview mode. You can now see the result when you alter the settings.

Click on the New Stroke Color button. By setting the different stroke colors, you can
further extract them into their own sublayers.
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Finally, click on Apply to All Frames button and CACANi will process the frames based
on the settings.

Vectorize Layer…
Converts Raster or Image Layers into Drawing Layers. Allows you to convert the raster
drawings into vector strokes. Raster region colors are not supported, they will instead
be turned into strokes. To get the best results for external images, you should use the
Extract Line Art option first.

Brightness
Determines the brightness of pixels to be considered in the vectorization process.
Higher values mean that brighter pixels are included in the process. This will lead to
a larger number of strokes as well as thicker stroke widths.
Accuracy
Determines how close the vector strokes should follow the original image. Higher
values mean that the strokes are more detailed but might not be smooth.
Despeckle
Determines whether small, isolated pixels are considered in the vectorization
process. Higher values mean that the vector strokes might have less details but are
smoother.
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Max Width
Allows you to control the maximum thickness of the vector stroke width. Higher
values mean that the maximum stroke width is thicker.
Include Color Separation Lines (no Anti-Aliasing)
When enabled, raster color strokes are converted into vector color separation lines.
However, if the stroke edges have anti-aliasing, the conversion results will not be
good.

Using Vectorize Layer
Right Click on the Raster Layer to bring up the context menu and select the Vectorize
Layer… option.

The Vectorization dialog window will appear.

Click Ok and CACANi will process the frames based on the settings. A new drawing
layer is created with the vector strokes above the raster layer.
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Using the Cel Bank - Frame View
Using the Playhead
The playhead shows the location of the active frame. You can scrub through the
animation sequence by Left Clicking and Dragging the Middle of the playhead. The
active frame is displayed on the Canvas.

Displaying Onion Skin Frames
Please see Chapter 08 – Displaying Onion Skin Frames.

Displaying Offpeg Frames
Please see Chapter 08 – Displaying Offpeg Frames.

Setting the Playback Range
You can set a specific range to be played back with the ‘In’ and ‘Out’ range tabs. Left
Click and Drag the ‘In’ range tab to the starting frame of your range, and the ‘Out’
range tab to the ending frame of your range.

Finally, enable the Playback Range icon to loop the playback.

User Manual
Cel Timing Adjustments
You can move a cel (and the layers within) forwards or backwards in time so that
different cels start / stop at different frames.

Maximizing / Minimizing a Cel
Cels can be minimized by Double Clicking on the cel frames in the cel bank frame view.
You can maximize the cel again by Double Clicking on the cel frames.

Frame Creation Window
In Frame View, you can create frames via the Frame Creation dialog window. You can
bring up this window by moving your cursor at the right end of a frame, or in the
gutter between 2 frames. The cursor icon will change. Left Click and Drag the cursor
to the right and the window will pop up.
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Frame Addition
The Frame Creation Window allows you to create different types of frame(s) or
sequences.
Duplicate Current Frame

Creates a copy of your selected frames.

Hold Current Frame

Creates a hold frame that extends the duration
of your selected frames.

Add Blank Key Frame(s)

Creates empty key frames for drawing.

Add Blank In-between Frame(s)

Creates empty in-between frames for
generating in-betweens.
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Sequence Looping
Other than adding frames, the Frame Creation Window also allows you to easily
duplicate a sequence of frames. Instead of selecting a single frame, use Shift + Left
Click to select a series of frames. Enter a numeric value to determine how many times
the sequence is duplicated.
Loop
Duplicates the selected sequence, with the frames
arranged in the same sequence.

Reverse
Duplicate the selected sequence, but with the frames
arranged in reverse order.

Ping Pong
Duplicate the selected sequence, but without
duplicating the last frame, and with the rest of the
frames arranged in reverse order.

As Repeat Frames
Used together with Loop, Reverse or Ping Pong
options. All the frames in the duplicated sequence
are repeated frames of the original frames.
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Frame Removal
To remove or delete frames, move your cursor at the right end of a frame, or in the
gutter between 2 frames. The cursor icon will change. Left Click and Drag the cursor
to the left and a confirmation window will pop up. Click OK to complete.

Frame View Context Menu

The Frame View context menu allows you to access additional options found in the
various main menus.
Please see Chapter 03 – Import, Chapter 03 – Frames menu and Chapter 03 – View
menu for more information.
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Frame Controls

Frames can be easily created or removed using any of the Frame Control buttons
located below the Canvas.

Cel Options Menu
Allows you to add or remove cels and layers in the Cel Bank.
Please see Chapter 07 - Layer / Cel Creation.

Frame Addition and Removal Buttons
Allows you to create/clear/delete frames without accessing the Cel Bank.

Add new Key Frames to the Left / Right
The first icon creates a key frame before the active frame, the second creates one
after the active frame. This affects all layers in the same cel.
In-between Frames
The first icon creates an in-between frame before the active frame, the second
creates one after the active frame. This affects all layers in the same cel.
Duplicate Frame
The first icon creates a duplicate frame before the active frame, the second creates
one after the active frame. This affects all layers in the same cel.
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Hold Frame
Allows you to extend the duration of the active frame.

Clear Sheet
Allows you to clear the strokes in the active sheet.
Clear Frame
Allows you to clear, or empty, all strokes in the active frame. This affects all the layers
in the same cel.
Clear In-between Frames
Allows you to clear all strokes in the in-between frame sequence. This affects all inbetween frames within the same pair of key frames, as well as all the layers in the
same cel.
Delete Frame
Allows you to remove the active frame from the cel sequence. This affects all the
layers within the same cel.
Delete In-between Frames
Allows you to remove all in-between frames within a pair of key frames. This affects
all the layers in the same cel.
Deleting and clearing of selected frames can also be done en-mass to a group of
selected frames.
Multiple frames can be selected either with Ctrl + Left Click to select different frames
or Shift + Left Click to select a range of frames.
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Cel and Layer Selection Bars
The Cel and Layer Selection Bars works with the same concept of frames, layers and
cels, but just displayed in a different manner. You can use the Cel Selection Bar to
select the cel you want to work on. When a cel has been selected, the layers within
the cel will be displayed in the Layer Selection Bar on the right.

Cels

Layers

Layer / Cel Tabs
Layer Header

Layer Name

Layer Opacity

Layer Status

Layer Header
By Holding Left Click and Dragging, you can reposition the specific layer and change
the display order.
Layer Name
You can Double Click to rename the layer here. In addition, when there are too many
tabs, by Holding Left Click and Dragging Up or Down on this portion of the tab, you
can scroll up and down the Layer Selection Bar.
Layer Opacity Slider
Similar to that in the Cel Bank, you can adjust the opacity level of the layer here.
Layer Status Icons
The layer status icons seen in the Cel Bank are also available here on the tabs.
In the Cel and Layer Selection Bars, you can Right Click to access the context menu for
adding and removing cels and layers.
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CHAPTER 08 – Animating & In-betweening

08
Animating &
In-betweening

User Manual

Your Own Animation Assistant
CACANi has been designed to harness the power of the computer in the hand-drawn
animation workflow. With information from the key frames, in-between frames can
be automatically generated and painted. At the same time, the artists retain full
control of the process, by being able to adjust the frames as and when they need.

Playback Bar
When animating, it is important to preview the sequence constantly. Only by looking
at the drawings in motion, will you be able to tell if the drawings are properly
animated, or require further tweaking and adjustments.

1

2

3

4

5

6

7

8

9

10

11

12

13

14

1

Undo
Cancels the previous action. You can undo up to a maximum of 50 actions (30
actions in 1.x).

2

Redo
Does the previous action again. You can redo up to a maximum of 50 actions (30
actions in 1.x).

3

Camera View Only
Hides drawings outside the camera frame during playback, so that you can see
how the final animation will look.

4

Playback Frame Rate
Sets the rate at which the sequence is played back, in Frames per Second (FPS).
Click and drag on the number to change the frame rate during playback or click
on the number to key in a new frame rate. A negative frame rate will reverse the
playback of the sequence.

5

Go to Previous Key Frame
Moves the Playhead to the previous key frame.

6

Go to Previous Frame
Moves the Playhead to the previous frame.

7

Current Frame / Time
Displays the current active frame or time. In addition, you can scrub through the
frames by Left Click and Dragging on the frame number. Dragging right will move
the playhead forward, while dragging left will move it backwards.

01 02 03 04 05 06 07 08 09 10 11
Animating & In-betweening

| CACANi

8

Play / Stop
Perform playback for the animation sequence. Click again to stop the playback.

9

Go to Next Frame
Moves the Playhead to the next frame.

10

Go to Next Key Frame
Moves the Playhead to the next key frame.

11

Playback Range, Start Frame, End Frame
When enabled, you can select the range of frames to playback. After the playback
reaches the End Frame, it loops back to the Start Frame. The frame numbers also
correspond to the Start Frame and End Frame Tabs in the Timeline.

12

Cycle Animation modes
In Repeat mode, after the playback reaches the end of the animation sequence,
it loops back to the first frame.

13

In Ping Pong mode, after the playback reaches the end of the animation sequence,
the sequence is played in reverse.

14

Quick Flip
Allows you to preview the animation from the previous key frame to the next key
frame by generating in-between frames temporarily.
Please see Chapter 08 – Quick Flip.

User Manual

Onion Skin Panel
The Onion Skin Panel is used for referencing other frames when drawing for better
accuracy in drawing. An Onion Skin Frame or Image shows you a view of what the
drawing is in the previous frame or the next frame. An Offpeg Frame, while also an
onion skin image, allows you to select specific frames for references. An offpeg frame
can also be transformed temporarily.

Onion Skin Display
Mode

Onion Skin
Image Color

Show Onion Skin
Images

Offpeg Frame
Color
Active Offpeg
Frame

Matching Frame
Onionskin Frame
Number and Toggle

Offpeg Frame

Onionskin Opacity
Bar
Master Onionskin
Opacity Bar

Opacity
Presets

Onion Skin
Display Settings

Onion Skin Display Mode
Allows you to change between Tint and Opacity display modes. Opacity mode also
preserves the original colors of the images.

Opacity Mode

Tint Mode
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Show Onion Skin Images
Allows you to toggle on or off the onionskin images.
To enable / disable onionskin images, click on the Onion Skin Image Display button
on the Onion Skin Panel. Alternatively, the Onion Skin Image Display option can also
be found in the Display Property Bar.

Onion Skin Image Color
Allows you to change the color of onion skin images before or after the active frame.
To do so, Double Click on the color selection box and a color selection dialog will
appear.
By default, onion skin images before the currently selected frame will be colored
green, those after the selected frame will be colored ochre brown.
You can change the colors of the onion skin images by Double Clicking on the color
selection boxes. This will trigger a dialog for onion skin image color changes.

User Manual
Matching Frame
Allows you to designate a frame for stroke matching. Because matching strokes are
normally confined to adjacent key frames, this will allow you to match strokes to nonadjacent frames.
The Matching Frame is viewed as an onionskin image, either on the canvas or in the
Navigator Panel, when Matching Frame mode is enabled.

Onionskin Frame Number and Toggle
Indicates the frame number relative to the active frame. Clicking on the number also
toggles on the onionskin image. When toggled on, the opacity bar will be shown in
color and the frame number is outlined in orange.

Onionskin Opacity Bar
Allows you to change the opacity value of the onionskin image displayed on the canvas.
Onionskin images further away from the selected frame will have lower opacity values
by default, thus giving an appearance of fading away. The opacity values of the
onionskin images can be changed by adjusting the onionskin opacity bars
corresponding to the onionskin images.
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Master Onionskin Opacity Bar
Determines the maximum opacity value of the onionskin images.
Alternatively, the maximum opacity can also be changed by adjusting the Master
Onionskin Opacity Bar.

Opacity Presets
A list of presets that changes how fast the opacity values of the onionskin images
fades.

Active Offpeg Frame
Selected Offpeg Frame. This is used when you need to move the Offpeg frame with
the Offpeg Tool.
Offpeg Frame
Offpeg frame bars. Activated when an offpeg frame is toggled in the Cel Bank.
Offpeg Frame Color
Allows you to change the color of the offpeg frames.

Onion Skin Settings

User Manual
Show Onion Skin Images
Displays drawings from other frames as onionskin images in the canvas. The
onionskin frames are relative to the playhead and active frame. When the
playhead is moved, the onionskin frames are changed as well.

Show Offpeg Frames
Displays drawings marked as Offpeg Frames in the canvas. Offpeg frames are a
different type of onionskin frames. They do not change when the playhead is
moved. They can be activated by Left Clicking on the dots above the Frame
Numbers in Frame View in the Cel Bank.

Show Onion Skin Images for Key Frames Only
When enabled, the onionskin images will only reflect the key frames, and skip the
in-between frames. Show Onion Skin Images option needs to be enabled.

Loop Onion Skin Images
When the currently selected frame is the last frame of the sequence, this mode
allows you to see the onionskin image of the first frame.
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Reset All Onion Skin Image Colors
Changes the colors of the onionskin images back to their default colors.

Reset All Offpeg Frame Colors
Changes the colors of the offpeg frames back to their default colors.

Clear All Offpeg Frames
Removes the active offpeg frame.
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Displaying Onion Skin Frames
The playhead in the Cel Bank can be used to display or hide onionskin frames. You can
do that by Left Clicking and Dragging the Edges of the playhead. The orange dots
indicate the onionskin frames displayed.
Left Click and Drag AWAY from the playhead to display onionskin frames.
Left Click and Drag TOWARDS the playhead to hide onionskin frames.

Displaying Offpeg Frames
The onionskin frames are relative to the playhead and active frame. When the
playhead is moved, the onionskin frames are changed as well.
Offpeg frames are a different type of onionskin frames. They do not change when the
playhead is moved. They can be activated by Left Clicking on the dots above the Frame
Numbers in Frame View. To deactivate the offpeg frame, Left Click on the dot again.

Adjusting Offpeg Frames
With the Offpeg Tool, you can move, scale and rotate offpeg frames. This is useful
when you need to use the offpeg frames as references for drawing other frames.
Please see Chapter 04 – Offpeg Tool.
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Timing Panel
In-between generation is one of the key functions in CACANi. Given two key frames
depicting extreme poses of an action, intermediate frames, aka in-betweens, can be
automatically generated by CACANi, creating a smooth motion. The Timing Panel
provides flexible control of in-between frame generation as well as easy adjustment
of their timing and spacing.

Timing Presets

Add / Remove Timing Presets

Apply Timing Preset

Lock

Lock

Lock

Update All Cels Mode

Update All Cels Mode

Active
Layer
Update
All Cels Mode
Add /Generate
Remove InIn-betweens
between Frames
button
In-between
Timing
Bar Preset
Apply
Timing
button
Lock
Layer Update Modes
Update All Cels Mode
Generate In-between
Generate
In-betweens
Frames
button
Apply Timing
Preset
Quick
Flip
button

Generate In-betweens button
Apply Timing Preset button

Generate In-betweens
button Generation
Skip In-between
for Frame
Apply Timing Preset
Auto Update
button In-between
Frames
Retain Stroke Connections

Quick Flip Generated Frames

Quick Flip Frame Rate

Timing Presets
Provides you with a number of frequently used settings for quick timing adjustments.
Click on the Timing Preset Button to update the In-between Timing Bar with the
selected presets.
Uniform
In-between frame markers are spaced the same distance from each other. The
motion between key frames will be at a constant speed.
Accelerate
In-between frame markers are spaced closer together as they approach the
second key frame. The motion between key frames will be speeding up.
Decelerate
In-between frame markers are spaced further apart as they approach the second
key frame. The motion between key frames will be slowing down.
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Accelerate -> Decelerate
The spacing between in-between frame markers is further apart in the middle,
and closer together when they approach the key frames on either side. The
motion between key frames will be slowing down, then speeding up.
Decelerate -> Accelerate
The spacing between in-between frame markers is closer together in the middle,
and further apart when they approach the key frames on either side. The motion
between key frames will be speeding up, then slowing down.

Add / Remove Timing Presets
Allows you to save customized timings from the In-between Timing Bar to the Timing
Presets dropdown menu or delete previously saved presets.
Apply Timing Preset
When clicked, any prior adjustments to the In-between Timing Bar will be cleared and
the markers will be moved based on the Timing Presets. However, this does not alter
the actual in-between frames. The frames will only be changed to the new timing if
the Generate In-between Frames button is clicked again, or if the Auto Update Inbetween Frames mode is enabled.

Active Layer
Shows the current selected layer.
Add / Remove In-between Frames
The first creates an in-between frame before the active frame, the second creates
one after the active frame.
The third icon allows you to remove the active in-between frame from the cel
sequence. The last allows you to remove all in-between frames within a pair of key
frames. These options affect all the layers in the same cel.
In-between Timing Bar
Shows the timing of in-between frames in the current pair of key frames. By adjusting
the position of the notches, it will allow you to change the speed of animation for the
in-between frames.
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Layer Update Modes
Allows you to select which layers or cels are affected by the timing adjustments.
Selected Layers
When enabled, only selected layers are affected by the timing adjustments.
Selected Cel
When enabled, all the layers in the active cel are affected by the timing
adjustments.
All Cels
When enabled, all cels with similar timing and frame types are affected by the
timing adjustments.

Generate In-between Frames
When clicked, it will generate in-between frames based on the settings in the Inbetween Timing Bar.
Skip In-between Generation for Frame
When enabled, the active in-between frame will be prevented from any changes or
updating due to timing adjustments in the Timing Panel. However, you will still be
able to manually adjust the strokes of the locked frame directly on the canvas.
Auto Update In-between Frames
When enabled, in-between frames will be updated instantly whenever the timing is
adjusted. However, this applies only to in-between frames that have been generated
already, and does not apply to blank in-between frames.
Retain Stroke Connections
When enabled, CACANi will help to minimize unwanted stroke gaps in generated inbetween frames.
Please see Chapter 08 – Retain Stroke Connections.
Quick Flip
Allows you to preview the animation from the previous key frame to the next key
frame by generating in-between frames temporarily. The preview animation is
generated for the active layer.
Quick Flip Generated Frames
Allows you to decide the number of frames that will be generated when using
Quick Flip.
Quick Flip Frame Rate
Allows you to decide the playback speed when viewing the Quick Flip generated
frames, in Frames per Second (FPS).

User Manual
Using the Timing Panel
1. Create the 1st key frame
Start by creating your first drawing in key frame 1.

2. Switch on the Onion Skin in the Display Bar

3. Create the 2nd key frame
Draw the second drawing in key frame 2, while taking note of the stroke matching
arrow indicators in key frame 1.
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4. Create Blank In-between Frames
Decide the number of in-between frames needed between the pair of key frames.

5. Adjust Timing for In-between Frames
By default, the in-between frames have equal timing, hence the speed of the
animation will be constant. However, movements in real life have irregular speeds.
When the frame markers are nearer, the animation will speed up. When they are
further apart, the animation will slow down. In this case, the animation is adjusted
such that the movement speeds up.

6. Generate In-between Frames
After the timing is adjusted, click on the Generate button. In-between frames will now
be created. In the example below, we can see the onionskin images of the in-between
frames. Note that the spacing between them is not constant, which is a result of our
timing adjustments earlier.
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Navigator Panel
The Navigator Panel provides a secondary view of your canvas, allowing you to pan,
scale and rotate around the canvas. Another important feature of the Navigator, is
that it can be used to display the Matching Frame, separate from the Current Frame
in the canvas.
Matching Frame Settings

View Modes
Canvas View

Show Sketch Layers

Zoom Presets
Zoom Level

Rotation Presets

Rotation Angle

Show Image Layers

View Modes
Allows you to switch between the 2 view modes. The Current Frame mode duplicates
the display of the main canvas, while the Matching Frame mode shows the Matching
Frame. This allows you to view and match strokes without the Matching Frame
cluttering up the main canvas.
Canvas View
Shows you a thumbnail view of the canvas. Also allows you to pan the canvas. Left
Click and Drag with the red frame (Current Frame mode) to re-position the canvas
window. The top right corner of the Canvas View shows the frame number displayed.
Zoom Presets
Allows you to select preset zoom percentages. This affects the zoom level in the main
canvas.
Zoom Level
Allows you to zoom in and out of the canvas. This affects the zoom level in the main
canvas. Left Click and Drag right on the slider to zoom into the canvas, Drag left to
zoom out of the canvas.
You can also key in the precise zoom percentage. Left Click on the number to input
any value from 1.6% to 6400%.
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Rotation Presets
Allows you to select preset rotation angles. This affects the rotation angle in the main
canvas.
Rotate Angle
Allows you to rotate the canvas for easier drawing of strokes. This affects the rotation
angle in the main canvas. Left Click and Drag right on the slider to rotate the canvas
clockwise, Drag left to rotate anti-clockwise.
You can also key in the precise degree of rotation. Left Click on the number to input
any value from -180° to 180°.
Show Image Layers
Allows you to show or hide image layers in the Navigator Canvas.
Show Sketch Layers
Allows you to show or hide sketch layers in the Navigator Canvas.
Matching Frame Settings
When using the Matching Frame View Mode, you can change various display
attributes of the Navigator canvas. These settings are not available when using the
Current Frame View Mode.
Show Stroke Directions in Navigator
When enabled, stroke direction arrows are displayed on the selected strokes.
Gray Out Matched Strokes
When enabled, strokes that have matched indices are shown in gray. This helps
you to identify the remaining strokes to match.

Matched Strokes (head) displayed as
black strokes

Matched Strokes displayed as gray
strokes

Select Matched Strokes
When enabled, strokes that have matched indices will still be selectable and
editable.
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Auto Focus on Stroke
When enabled, the selected stroke will be centered in the Canvas View.
Synchronize Pan
When enabled, panning in the preview window will affect the canvas as well.
Synchronize Zoom
When enabled, zooming in and out in the preview window will affect the canvas
as well.

Using the Navigator Panel – Canvas Navigation
Please refer to Chapter 02 – Canvas Navigation.
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Using the Navigator Panel – Matching Frame Mode
In this mode, the Navigator allows you to view a frame that has been designated as a
Matching Frame. As CACANi’s in-betweening system works by corresponding strokes
in a pair of key frames, a Matching Frame refers to the key frame used for stroke
matching in the current or active frame.

Navigator Current Frame Mode

Navigator Matching Frame Mode

This helps you to separate the strokes in the Matching Frame from the strokes you
need to draw in the active frame. This is especially useful when the drawings are very
complex.

Onion Skin enabled,
Navigator Current Frame Mode

Onion Skin disabled,
Navigator Matching Frame Mode

User Manual
In the Navigator context menu, there are 2 options, Smart Paste Selected Strokes
and Re-match Stroke Order. You can see their usage below.

Using Smart Paste
Strokes copied and pasted using Smart Paste are adjusted to fit other existing
strokes in the active frame. For Smart Paste to work for a stroke, the destination
frame should have existing strokes that were connected to the selected stroke in the
initial frame.
In the example below, the details in the handle haven’t been drawn in Frame 2. By
using Smart Paste Selected Strokes in the Navigator, the indicated stroke has been
copied over and morphed to fit the space between the existing strokes of the
handle.
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You can also copy over all remaining strokes using Smart Paste All Strokes in the Edit
menu.

Using Re-match Stroke Order
When making complicated drawings, it is quite common to mismatch strokes in key
frames. Using the Navigator and the Re-match Stroke Order feature, you can easily
correct those mistakes.
In this example, some of the strokes were not matched correctly, so the generated
in-between frames do not look good.

User Manual
To fix this, select the 2nd Key Frame, or Frame 4. In the Navigator, remember to
choose Matching Frame mode. You should see the 1st Key Frame, or Frame 1.

Using the Selection Tool, first select the hair stroke in the current frame. Then select
the same hair stroke in the Matching Frame (in the Navigator). You can see that the
stroke for the hair is wrongly matched to the stroke for the cheek, as both are
highlighted in green.
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Still in the Navigator, Right Click and select Re-match Stroke Order.

The hair stroke should be matched in the key frames now. Both strokes are
highlighted in green.

Double Click on the in-between frames so that it’s updated. The mismatched strokes
are now fixed.
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Using Join Strokes and Cut Stroke
Sometimes, using Re-match Stroke Order alone is not sufficient to fix problems with
mismatched strokes. For example, when the user did not refer to the onion skin
image when drawing, or when a drawing was vectorized.
In this example, the character’s hair was drawn with 3 strokes in the 2nd key frame.
As a result, they could not be matched with the 1st key frame.

The Join Strokes option lets you combine strokes that are connected at a common
end point. Select the strokes using the Selection Tool, then Right Click to bring up
the context menu. Select the Join Strokes option.

After joining the strokes, use Re-match Stroke Order to fix the mismatched strokes.
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Conversely, you can also cut a stroke to make the matching work. Using the same
example, select the stroke for the hair in the 1st key frame with the Stroke Editor.
With your cursor on the stroke, Right Click to bring up the context menu, then
choose the Cut Stroke option. Try to cut the stroke at a spot similar to those in the
2nd key frame.

After cutting the stroke into 3 strokes, move to the 2nd key frame and use Re-match
Stroke Order to fix the mismatched strokes. You can match the strokes one by one,
or you can use Shift + Drag to select and match all 3 strokes at the same time.
However, you need to make sure that the strokes are selected in the same order for
both key frames.

Double Click on the in-between frames so that they’re updated. The mismatched
strokes are now fixed.
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Using the Feature Point Tool
When generating strokes from a key frame, there are times when you will require the
stroke to deform in a specific way. For example, when drawing smoke animation, the
‘bump’ in a stroke should move through the stroke. That can be achieved with the
Feature Point Tool.
As an example, we have 2 key frames below, drawn with only 1 stroke:

The generated in-between frames (in red) will look like this:

To create an effect where the ‘bump’ moves through the stroke, the in-between
frames will look like this:

To do so, use the Feature Point Tool to select the stroke in the first key frame. The
second key frame is highlighted in green.

Right Click at the highest point of the ‘bump’ to bring up the context menu and select
Add a Feature Point. A dashed path will appear, leading from the first key frame and
ending on the second key frame. This indicates how the stroke moves at that point.
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Move the ending point of the path to the bump on the second key frame.

Generate the in-between frames this time will give you the following result.

You can also adjust the path to modify the generation of the in-between strokes.
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Using Boundary Strokes
Boundary strokes provide you with a way to hide sections of your drawing by
mimicking how different objects overlap each other. Compared to masks, you do not
need to worry about gaps or make sure that the strokes in a mask form an enclosed
region. In addition, the stroke depth feature helps to reduce the need to organize
your strokes in multiple layers. Boundary strokes are only usable in Drawing Layers.
A boundary stroke can hide another boundary stroke, if the latter stroke has the
occluded stroke property and a lower stroke depth than the former.

Assigning Boundary Strokes
Boundary Stroke assigning is done with the Selection tool.

To use boundary strokes, you need to both choose a boundary stroke and decide
which strokes are going to be affected or occluded by boundary strokes. First choose
the stroke to be assigned as the boundary stroke.
A new boundary settings panel will appear under the selected stroke. Select the
Hide Strokes… option.

You will see the instructions, ‘Hide at this Location’ following your cursor. This allows
you to decide whether the boundary stroke will hide the drawings on its left or right.
The sides of a boundary stroke are based on the stroke direction.
Click on the right side of the selected stroke. A series of diagonal lines on the right
side of the stroke indicates the ‘hiding side’.
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In addition, when a stroke is assigned as a boundary stroke, the stroke’s depth is
automatically increased by 1, so that it is above other strokes.

Although you have created a boundary stroke, all strokes are still visible. By default,
all strokes are non-occluded strokes and are unaffected by boundary strokes. You’ll
need to pick the strokes that are going to be affected, called Occluded Strokes.
Depending on their location in relation to the boundary stroke, sections of the
strokes are hidden when they intersect. When both boundary strokes and occluded
strokes are assigned, you will see a change in the visibility of the occluded stroke.

However, the blouse should only be hidden by the overlapping section of the arm.
So you will need to set the other strokes of the arm as boundary strokes. But this
time, these strokes will help to reveal the blouse again.
There can be more than 1 boundary stroke. When that happens, strokes will be
hidden based on the nearest boundary stroke.
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If you adjust the boundary stroke or the occluded strokes using the Selection Tool,
the visible segments will change.

Multiple Boundary Strokes and Stroke Depth
In addition to boundary strokes, you can now assign depth to your strokes. This is
useful when you need to have objects hiding each other. In the example below, the
right leg is hidden by the left leg, which is in turn hidden by the blouse.

Start by setting the right leg as occluded strokes.

For the left leg, you will only need to select the outermost stroke. Assign it to be
both a boundary stroke (to hide the right leg), as well as an occluded stroke (to be
hidden by the blouse).
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Also, the depth of a boundary stroke is automatically raised by 1. The depth of a
selected stroke can be seen in brackets on the canvas or in the stroke depth
indicator.

With the legs done, the final step is to hide the legs with the blouse. Set the stroke
to be a boundary stroke and change the stroke depth to 2.

It is important to make sure that both legs are set to be occluded, and that the
stroke for the blouse is at a higher depth, in this case, 2, than the legs, which are at
depths 1 and 0.

Animating Boundary Strokes
The effects of using boundary strokes can be replicated to other frames in 2 ways;
by using inbetween generation, or by using the Transfer Boundary Stroke Settings
option. The same stroke indices in the other frames will inherit the boundary and
occluded strokes settings.
If the first key frame has boundary and occluded strokes, after generating the
inbetween frames, they will have strokes with similar properties. However, the
properties are not transferred to the second key frame, so the boundary and
occluded stroke settings need to be assigned manually.
Alternatively, the Transfer Boundary Stroke Settings option allows you to choose the
frames to copy to. Please take note that the source frame with the boundary stroke
assigned should be the first frame in the selection. Use Left Click + Drag / Shift + Left
Click to select frames in sequential order or use Ctrl + Left Click to pick isolated
frames in the Cel Bank. If you want to transfer the settings to all the frames, you
only need to select the first frame.
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Then Right Click on any of the selected frames to bring up the context menu. Select
the option, and the boundary and occluded settings in the first frame are copied to
the rest of the frames.

Editing Occluded Strokes Manually
If you want to make manual adjustments to the visibility of occluded strokes, you
will need to disable the Auto Update Occluded Strokes option. (View menu > Stroke
Display Options submenu).

When the Auto Update Occluded Strokes option is disabled, and you wish to update
the visibility of individual occluded strokes, you can use the Update Selected
Occluded Strokes option. It is found in the Frames menu, or the Cel Bank’s context
menu.
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In addition, you can also update the occluded stroke ‘s visibility in the other frames,
as long as the frames are selected in the Cel Bank, and the same stroke index in the
other frames already have the occlusion property assigned to them.

Occluded Strokes and Hidden Segments
You can also use the Segment Tool to manually edit the visibility of the stroke
segments.

However, by default, an occluded stroke is not affected by the Segment Tool. The
difference between Occluded Strokes and Hidden Strokes is that occluded strokes
are affected by boundary strokes while hidden strokes are not. To use the Segment
Tool properly, the Auto Update Occluded Strokes option needs to be disabled.

Subsequently, you will be able to manually edit occluded strokes. This manual
editing has a limitation: if the Auto Update Occluded Strokes option is re-enabled
and further changes are made to the stroke, the manually added segments will not
remain.
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Using Stroke Groups and Masks
Stroke Grouping allows you to manipulate multiple strokes at the same time. In
addition, the Bone Tool will only work with groups, not individual strokes.
Enabling Auto Group mode will cause each stroke to be grouped individually, so that
bones can be created for each stroke.
Strokes can be grouped in both key frames and inbetween frames.

How to Group and Ungroup Strokes
Stroke grouping can be done with the Selection tool.

Select the strokes on the canvas. Take note that you can only group strokes on the
same layer.

Right Click while hovering over any of the selected strokes. From the context menu,
choose Group/Mask, then Create Group. If the option does not appear in the context
menu, it could be because you have selected strokes from multiple layers.
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Strokes will now be grouped. The selection box is now orange.

To ungroup, Right Click while the group is selected. Choose Ungroup from the context
menu.

Changing Group Display Order
When you find that a group of strokes is hiding sections of a drawing or another
group in an incorrect way, you may be able to fix the problem by changing the group
display order.
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Use the Selection Tool to pick the group and Right Click on the group to bring up the
context menu. From the Arrange option, select Send to Front. Now the group is
rendered behind other groups.

Groups, Masks and Clipping Masks
Masks and Clipping Masks are similar to groups, with the difference being that the 2
types of masks will also hide or reveal strokes even when the regions are not painted.
But like groups, you will need to make sure that the regions are closed for the masking
to work properly.

When you turn a set of strokes into a Mask, the region enclosed within the strokes
will hide strokes from other groups. This is a good way to see how your final drawing
will look like without first painting the regions. A mask has a green selection box.
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In contrast, a Clipping Mask will display strokes within its closed regions and hide
strokes outside of its regions. A clipping mask has a purple selection box.

Setting the Masking Level
When using masks, you can also decide how the mask affects strokes in other layers
and cels. When the mask level is set to Layer, the mask will only affect strokes and
groups in the same layer. When set to Cel, the mask will affect strokes and groups that
can be on different layers, but within the same cel. Finally, setting the mask level to
Cut means that the mask will also affect strokes and groups in other cels. However,
do take note that strokes and groups can only be hidden if they are on a layer or cel
below the mask.
In this example, we have already turned the smiley face into a mask.
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The cap is on a layer within the same cel as the faces. So, you need to create a mask
for the cap and set the masking level to Cel.

The window is drawn on a different cel. To show the faces looking out of the window,
a clipping mask needs to be used. And because the faces are on a different cel, the
masking level has to be set to Cut.
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Finally, because the external section of the window is hidden by the clipping mask, we
need to group the strokes together. After doing so, the strokes are automatically
displayed above the clipping mask.

Editing Strokes within Groups and Masks
When you need to select or edit strokes within a group or mask, you need to turn off
the Select Groups option found in the Selection Tool properties.

Animating Groups and Masks
Stroke groups and masks are not created when generating inbetween frames.
Instead, they can be replicated to other frames by using the Transfer Grouping Info
and Replace Grouping Info options in the Cel Bank. The same stroke indices in the
other frames will inherit the grouping information.
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To use either of the options, use the Selection Tool to choose the frames to copy to.
Please take note that the source frame with the grouping information should be the
first frame in the selection. Use Left Click + Drag / Shift + Left Click to select frames
in sequential order or use Ctrl + Left Click to pick isolated frames in the Cel Bank.
Then select either of the options by Right Clicking on any of the selected frames to
bring up the context menu.

The difference between Transfer Grouping Info and Replace Grouping Info is that
the former will update those strokes without any groups or masks, while the latter
will overwrite existing grouping information in the destination frames.
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Using the Bone Tool
By default, the automatic generation of in-betweens is set to straight in-betweens.
How, artists frequently utilize motion arcs for more natural animations. The extent of
motion arcs can vary from animation to animation, and indeed, a single character
usually has body parts moving with multiple motion arcs.
The Bone Tool allows you a further level of optimization and control in the generation
of in-betweens. By specifying the motion arcs, in-betweens can be adjusted for more
accurate animation.
The Bone Tool can only be created and adjusted from groups in key frames.

Creating Bone Paths
1. In this example, the character is turning his head. But the default generated inbetweens make the animation very robotic. The head should be moving in an arc,
not a straight line.
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2. Begin by selecting the strokes for the head with the Selection tool, then Right
Clicking to group them. This is required as the Bone Tool is only usable in groups.

3. After creating a group, select the Bone Tool. Click on the strokes in the group. A
bounding box will appear around the strokes. At the same time, a second
bounding box showing the same strokes in the next frame will be displayed in
green.

4. With the group still selected, start the first motion arc by Left Clicking somewhere
near the top of the bounding box and dragging a straight line to a similar area in
the second bounding box. Upon release of the mouse, adjust the motion arc by
moving your mouse while hovering. Left Click again to confirm the arc.
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5. The second motion arc is drawn in the same way. For better results, it’s
recommended to place the second arc near to the bottom of the bounding box.

6. With that, the in-between frames can now be generated via the Timing Panel.
Compared to the original in-between frames, the new ones now move according
to the motion arcs described by the artist.

Bones can only be created on key frames and will only affect the in-between frames
within a pair of key frames. As such, separate bones and motion arcs will have to be
created for the next pair of key frames.
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Synchronizing Multiple Bones
When multiple groups are created, each can have a set of bones. In this case, it’s
important to synchronize the movement of the bones.
In this example, the body and head are in different groups. To synchronize the body’s
bone movement to the head, select the body group with the Bone Tool and press Ctrl.
All the motion paths will be highlighted.

Left Click on the highlighted motion path to synchronize the body group with the head
group. Create the second motion path near the bottom of the body. The body group
is now synchronized with the head group.
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Changing Stroke Widths
One advantage of using vector strokes in CACANi is that you can still adjust the
stroke widths after they are drawn. There are a few ways you can do this in CACANi.
You can use the Stroke Width Tool for adjusting single strokes, the Change Stroke
Width option which affects single or multiple selected strokes, the Stroke Taper
Panel to adjust the stroke widths as you draw them, and finally the Stroke
Magnification option during the exporting process.
For this example, we are thickening the strokes of one of the faces.

This can be done with the Selection Tool and the Change Stroke Width option. Select
the smiley face, then Right Click to bring up the context menu.
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You can choose to change the thickness to a constant value, or if the stroke width
has varying thickness, you can choose to change it by a percentage.

In addition, you can apply the change to multiple frames. You just need to Shift +
Drag to select the frames you need first, then choose the Change Stroke Width
option. All the selected frames will receive the changes applied.

Please also see Chapter 04 – Stroke Taper Panel, Chapter 05 – Stroke Width Tool
and Chapter 10 – Stroke Magnification.
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Using Stroke Connection Points
Connecting strokes to each other are an important part of the drawing and painting
process in CACANi. To ensure that strokes remain connected when transforming
them, you can use the Add Stroke Connection Points option after you finish cleaning
up your drawings.
In this example, the animation drawings are already complete. But when you scale
the drawings, you may find that gaps can appear.

Adding Stroke Connection Points helps you define the intersections much more
accurately. However, because of the additional points, stroke editing is harder.
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With the connection points, regions will not change when scaling or rotating.

You can also apply the option to selected strokes in multiple frames. Select the
frames first before using the option.

Alternatively, you can enable the Add Points When Clinging option so that when
you’re drawing or editing strokes, a connection point is added to the stroke you’re
snapping to. When the stroke end is shifted away, the connection point is also
removed.
Please see Chapter 04 – Add Points When Clinging.

Adding Stroke Connection Points are best done when the drawings are almost
complete. Conversely, if you need to edit points extensively, you can use the
Remove Stroke Connection Points option.
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Retain Stroke Connections
The Retain Stroke Connections function is a tool to help minimize unwanted stroke
gaps in generated in-between frames. This will make it easier for artists to paint the
in-between frames at a later stage. The function can be found in the Menu Bar, under
the Tools menu.

When an end of a stroke connects with another stroke, they form a T intersection as
shown in the figure below.

This function first detects T intersections in key frames. When found, it generally
means that the strokes are connected to each other and will form regions. Based on
this information, CACANi will try to ensure that the same strokes are connected in the
automatically generated in-between frames as well.

Using the Retain Stroke Connections Function
1. The example below shows a simple sequence with 2 key frames and 2 generated
in-between frames.

Key frame 1

In-between 1

In-between 2

Key frame 2
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2. You will be able to notice that in the in-between frames, the blue separation
stroke does not touch the black outline, unlike the key frames.

Gap in In-between 1

3.

Gap in In-between 2

Select Frames menu > Retain Stroke Connections (All In-betweens). Since T
intersections can be found in key frames 1 and 2, the function will automatically
close the gaps between the strokes in in-between frames 1 and 2.

4. The stroke gaps are now closed and the in-between frames are ready for painting.

Key frame 1

In-between 1

In-between 2

Key frame 2
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Guidelines for In-betweening
CACANi’s unique in-betweening technology allows strokes to be automatically
generated in in-between frames. However, to get the best results, there are a few
guidelines to follow when drawing your key frames.

Separate Strokes for Different Parts
When drawing in CACANi, it is recommended to try to relate each stroke to a part of
the object or character you are creating. In the example below, you can recognize that
the object comprises of 2 distinct parts, the lid and the can. By drawing separate
strokes (represented with different colors) for the lid and can, it will be easier for you
to in-between the opening of the lid automatically.

Generated In-between Frames

Conversely, if you had drawn the lid and can with only 2 strokes (1 orange stroke and
1 blue stroke), the in-betweening result will not be good.

Generated In-between Frames
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In-betweening Sharp Angles
When drawing an object or a character with sharp angles, like the example below, it
is recommended to have separate strokes as well. This will help maintain the sharp
angles in the in-between frames.

Generated In-between Frames

It is harder to generate in-between frames accurately when there are multiple sharp
angles within a stroke.

Generated In-between Frames
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Corrective Features for Stroke In-betweening
It is inevitable that mistakes will be made when cleaning up key frames in CACANi. For
example, strokes were drawn in the wrong direction, or in the wrong order. When
that happens, you can make use of corrective features like Change Direction and Inbetween Selected Strokes, found in the Selection tool’s context menu.
In the example below, one stroke is flipped in the generated in-between frames due
a problem with stroke direction in the key frames.

Generated In-between Frames

To view the stroke direction, use the Selection tool to select the stroke in the key
frames.

Still using the Selection tool, Right Click on the stroke in the first key frame to bring
up the context menu. Choose Change Direction.
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After changing stroke direction, the stroke can be updated in the in-between frames
using the In-between Selected Strokes option, without affecting the other strokes.
This is especially useful in cases when there have been extensive changes made to the
strokes in the in-between frames.

With the corrections, now the in-between frames are generated properly.

Hiding Stroke Segments Last
During the process of animating, there is always a high chance that the strokes in the
key frames or in-between frames need to be changed. As such, it is generally a good
practice to leave any stroke segment editing / hiding to when the key frames are
almost finalized, or after the in-betweening process has been carried out.
Keeping this in mind will help minimize time spent in the re-editing of stroke segments.
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CHAPTER 09 – Painting Your Animation

09
Painting Your Animation

User Manual

A Dash of Sunshine
With all the innovation found in the in-betweening tools, we have tried to do the same
with the painting process, by leveraging on the key frame information gathered earlier.
As a result, CACANi has an intelligent painting system that will help you to paint
animation frames automatically.
But before continuing with the different painting tools, there is a need to understand
how painting works in CACANi. On the canvas, before painting can be done, you must
ensure that the strokes form closed regions. That can be done with the Clean Up Tool,
or you can use the Stroke Editor to adjust the strokes so that they cling to each other.

Please refer to Chapter 05 – Stroke Editor and Chapter 05 – Clean Up Tool for
different ways to prepare for painting.

You can use the various region display modes to check if the regions are indeed closed.

Please refer to Chapter 06 – Region Display Modes for more information on different
ways of displaying regions.
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Cross Layer and Single Layer Regions
Next is the concept of cross Layer regions and Single Layer regions. In this example, as
the strokes were all drawn in 1 layer, the region formed by the 4 strokes is a Single
Layer Region, or Self Region. The Single Layer Paint Tool is used to fill in the region.

To verify this, you can enable the Highlight Single Layer-Regions display mode. All
single layer regions will be displayed with a checkered pattern.
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On a new layer, a green stroke is drawn. This new stroke does not affect the single
layer region underneath.

Rather, because the new layer is above the single layer region, it intersects with the
first 4 strokes and creates 2 distinct new Cross Layer Regions. This is apparent when
using the Cross Layer Paint Tool results in the new light blue region.
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The single layer region still shows the checkered pattern, while the light blue cross
layer region doesn’t. In this case, as the green stroke is above the other 4 strokes that
form the single layer region, the cross layer region hides the single layer region.

By reversing the order, now the 4 strokes are above the green stroke. As a result, the
orange single layer region is now hiding the light blue cross layer region, as well as the
green stroke. In Highlight Single Layer Regions display mode, the translucent single
layer region reveals the cross layer region.
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Taking the example further, another green stroke is added to the bottom layer,
connecting the first green stroke in the bottom layer to the black stroke in the top
layer.

Because the strokes that make up this region belong to different layers, there is no
single layer region formed. Using either the Cross Layer Paint Tool or the Single Layer
Paint Tool will result in a cross layer region with no checkered pattern.
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Another difference between single layer regions and cross layer regions is the layer
where the color information is stored. Since single layer regions are formed by strokes
on a single layer, the color information is naturally stored together in the same layer.

Single Layer region colors
(stored in top layer) hiding
Cross Layer region colors
(stored in bottom layer)

When top layer is hidden,
Single Layer-region colors
disappear, but bottom Cross
Layer region colors remain

However, as cross Layer regions are formed by strokes from different layers, color
information is stored in the bottom-most layer. Understanding this is important,
especially when attempting to hide layers.

‘Green strokes’ layer moved to
top layer, Self-region colors
moved to bottom layer
together with strokes

Cross Layer region and Selfregion colors now stored
together in bottom-most layer
and are both hidden at the
same time
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Color Panel
The Color Panel is where you can define or change colors for selected strokes and
regions. You can also store color swatches for adjustments or testing.

Active Stroke Swatch
Active Region Swatch
Quick Access Stroke Palette
Quick Access Region Palette
Color Palette
Palette Loading and Saving
Color Selection Tabs
Color Wheel

Alpha Slider
HSV Color Sliders

RGB Color Sliders
Color Mixers

Active Stroke and Region Swatches
When active, it’ll allow you to set or change the color of the selected strokes or region.
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To change stroke colors, use the Selection tool to select the strokes.

Left Click on the Active Stroke Swatch to make sure that the color adjustment will
apply to strokes and not regions.

Enable the Color Wheel Selection Tab (CW). Left Click and Drag the circular indicator
to a different color in the color wheel. The color in the Active Stroke Swatch is now
changed.

The color of the selected stroke on the canvas is also changed.
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Unlike strokes, regions cannot be selected. Left Click on the Active Region Swatch to
make sure that the color adjustment will apply to regions and not strokes.

Adjust the indicator on the color wheel to change the color in the Active Region
Swatch.

Select the Cross Layer Paint Tool and Left Click on a closed region on the canvas to fill
it with the selected color.
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Quick Access Stroke and Region Palettes
Allows you to select swatches quickly from the dropdown menus in the stroke drawing
tools or Cross Layer Paint Tool property bars. With the quick access palettes,
frequently used color swatches can be accessed from the property bar, and the need
to have the Color Panel opened all the time is reduced.
Quick Access Stroke Palette

Quick Access Region Palette

To add swatches to the quick access palettes, open the Color Panel. Hold Alt and Left
Click on any of the empty quick access swatches.

To use the quick access swatches, select any of the Drawing Tools, Painting Tools or
the Selection tool. Left Click and Hold on the Color Selection Box in the property bars.
Left Click on a quick access swatch, and it will replace the color in the Active Swatch.
Quick Access Stroke Palette
Quick Access Region Palette
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Color Palette
Allows you to store color swatches for easier selection.

To add a swatch to the color palette, first select a color from either the color wheel or
the color sliders.

Then Hold ALT and Left Click on one of the empty swatches in the color palette. The
color is now added.
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Palette Loading and Saving
Allows you to swap color palettes. Color palettes can be saved as .csf files.

Save Palette
Saves the current color swatches as a palette to a .csf file.
Load Palette
Replaces the current color swatches with a new set from a .csf file.
Clear Palette
Removes all color swatches.

Color Selection Tabs
Allows you to display or hide the color wheel and various color sliders.

Color Wheel [CW]
Allows you to define colors for the Stroke or Region Swatches through visual selection.
The color wheel consists of an outer color circle, and an inner brightness square.
Enable the color wheel by Left Clicking on CW.
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Alpha Slider [A]
Allows you to define the alpha, or transparency, value of a color for the Stroke or
Region Swatches. To change the alpha value of selected strokes, enable the Alpha
slider by Left Clicking on A.

Adjustments can be made by either Dragging the triangular indicator, or by Left
Clicking on the input field to key in the new value directly.
OR
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Colors with different alpha values can also be stored as swatches in the Color Palette.

HSV Sliders [HSV]
Allows you to define colors through the adjustment of H (hue), S (saturation) and V
(black level) values. Enable the HSV sliders by Left Clicking on HSV.

TIP!

It’s easier for artists to select colors using the HSV sliders than the RGB sliders,
mainly because HSV sliders are visually easier to understand.

RGB Sliders [RGB]
Allows you to define colors through the adjustment of R (red), G (green) and B (blue)
values. Enable the RGB sliders by Left Clicking on RGB.
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Color Mixers [CM]
Allows you to define colors through the mixing of two user-assigned colors on either
end of the slider. Enable the color mixers by Left Clicking on CM.

To assign colors to the mixers, you will first need either the color wheel or the color
sliders. The HSV sliders are used in this example.
Adjust the sliders to a color of your desire. Apply the color by Left Clicking on one of
ends of a color mixer.

Select another color, and then apply the second color to the other end of the same
color mixer.
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Now you can adjust the circular indicator to get a new color mixed from the selected
colors. Keep this new color by Holding down Alt and Left Clicking on the color palette.

Color Picker Tool
Allows you to sample colors from the canvas. The colors can be from a stroke or region
on the canvas, or from a loaded image in the Image Layer.

Using the Color Picker Tool
Select the Color Picker Tool and Left Click anywhere on the canvas. The color at the
spot will be reflected in the Active Swatch in the Color Panel.
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Cross Layer Paint Tool, Single Layer Paint
Tool Difference
The main difference between the Cross Layer Paint Tool and the Single Layer Paint
Tool is the latter’s ability to determine and paint self-regions.
The Cross Layer Paint Tool does not determine whether strokes are forming selfregions and can only create cross Layer regions. Hence, it is more useful and efficient
when painting elements that do not require regions to hide, or occlude, each other.

Cross Layer Paint Tool / Single Layer Paint
Tool
Allows you to fill a closed region with the selected color by Left Clicking or Dragging
on the region.

Using the Cross Layer Paint Tool
To paint a closed region, first pick a color using the Color Panel’s palettes or color
sliders, then Left Click within the region.
To remove color from a painted region, Right Click within the region.
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You can also use drag selections to paint multiple regions, or remove color from
multiple painted regions. To do so, Left Click and Drag a rectangular selection over
regions to be painted. Any region that falls within the selection will be filled with the
same color.
Conversely, to remove colors from multiple painted regions, Right Click and Drag a
selection over them.

TIP!

When painting regions, you may find that certain regions cannot be painted.
One reason for this may be that the strokes forming the region have gaps
amongst them.
Please see Chapter 05 – Clean Up Tool for more information.

Sampling Colors from an Image
Other than selecting colors from the Color Panel, you can also toggle the Color Picker
Tool from within the Cross Layer Paint Tool. Colors can be sampled from drawings
created in CACANi as well as images loaded from external sources.
First, load an image into CACANi.
Please see Chapter 07 – Image layers for more information.
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With the Cross Layer Paint Tool selected, Hold ALT + Left Click on the colored image,
then Left Click on the character’s face. The face is now painted with the color sampled
from the image.

In this way, artists will be able to quickly sample colors from images and reduce the
need for the Color Panel.

Cross Layer Paint Tool Properties
Cross Layer Paint Tool has similar properties with Single Layer Paint Tool.

1

2

1

Replace Existing Color
When enabled, you will be able to replace colors in painted regions.

2

Region Color Selection Box
You can set the region color by Double Clicking to bring up the Color Selection
Box dialog box. When done, just Left Click OK to confirm.
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Using the Color Reference Window
Other than loading the images into an image layer, you can also use the Color
Reference Window from the View menu to load your images.

From the Color Reference Window, you can Left Click on the Load Image icon to bring
up the selection dialog box to load an image.

When you Left Click anywhere on the loaded image, the color value at that pixel is
sampled and automatically recorded as an active swatch in the Color Panel.
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Using the Cross Layer Paint Tool, you can proceed to paint the corresponding regions
in the canvas.
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Assisted Painting System
Painting animation frames has always been a time consuming process, even on a
digital, paperless workflow. However, CACANi’s assisted painting feature will allow
you to finally surmount this obstacle. By taking a painted frame as reference, CACANi
can automatically paint the rest of the animation sequence for you, helping you save
time and money.

Auto Coloring Panel
The Auto Coloring Panel provides you with tools to paint the frames easily. Activate it
from the Panel Display Bar.

Apply to all Cels
mode
Replace Existing
Color mode
Auto Color Other
Frames
Auto Color Current
Frame

Apply to All Frames
mode
Exclude Selected
Frames mode
Update Region
Colors
Clear Region Colors

Apply To All Cels mode
When enabled, Auto Color Other Frames, Auto Color Current Frame, Update Region
Colors and Clear Region Colors will affect all cels.
Auto Color Other Frames
The painted regions of the current frame will be used to paint all other frames or
frames in a selection.
Auto Color Current Frame
Regions in the active frame will be painted with colors from the previous frame, or
adjacent frames.
Replace Existing Color mode
When enabled, Auto Color Other Frames and Auto Color Current Frame will replace
colors in painted regions when applied.
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Apply To All Frames mode
When enabled, Update Region Colors and Clear Region Colors will affect all the
frames within the active layer.
Exclude Selected Frames mode
When enabled, Update Region Colors and Clear Region Colors will not affect the
selected frames within the active layer.
Update Region Colors
If the regions of the selected frame are already painted, this will restore the display
of the colors in those regions.
Clear All Region Colors
When pressed, all region colors in the selected frame will be erased.

Using Auto Painting
First, ensure that the regions to be painted in the animation frames do not have any
unwanted gaps. This can be done by using the Cross / Single Layer Paint Tools and Left
Clicking on any open areas to check for unclosed regions.

Select one of the animation frames and paint it. This will provide CACANi with the
painting information for the rest of the animation sequence.
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With the painted frame active, select the Auto Coloring Panel. Left Click on Auto
Color Other Frames. CACANi will now analyse and paint all other prior and subsequent
frames in the animation sequence automatically.

IMPORTANT: The auto coloring process is based on matching strokes. If the regions
are enclosed by the same strokes in all the frames, the auto coloring will be very
accurate. In the example below, the character’s head is based on the same stroke
indices 01-05.

So, the color regions enclosed by the same strokes in the head will be successfully
painted automatically.
In addition, it is useful to understand how the auto coloring process works. From the
1st painted frame, it will be used to paint the 2nd frame. The 2nd frame will be used to
paint the 3rd frame. The process continues until there are no more frames.
If there are still unpainted regions, you can use the Cross / Single Layer Paint Tools to
manually paint those regions.

Auto Paint Single Frames
In the event that a new frame is created, or some adjustments were made to a painted
frame, you can repaint the frame automatically without affecting the rest of the
sequence.
Select the unpainted frame.

User Manual
Apply Auto Color Current Frame from the Paint / Single Layer Paint Tools. The
selected frame will be painted based on the nearest painted frame.

TIP!

Auto Color Current Frame is very useful when there are more complex
drawings. You can check the painted frames one by one before applying Auto
Color Current Frame to the next frame.

01 02 03 04 05 06 07 08 09 10 11
Painting Your Animation

| CACANi

CHAPTER 10 – Completing Your Animation

10
Completing Your
Animation
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Saving the Animation
From the menu bar, select File > Save or Save As. Alternatively, press Ctrl + S or Ctrl
+ Shift + S to save a file.

When you choose Save, if the file has not been saved before, a Save dialog box will
appear. If not, no dialog box will appear and the file will be saved immediately. When
you choose Save as, a File Save As dialog box will always appear.

You will be required to enter a file name for their files. The CACANi Documents format
(*.cacs) is the file format for CACANi. All file information is saved.

Save as Project
Creates a folder and lets you save your work along with external image, video
and/or audio files that are currently loaded in CACANi. It is useful for consolidating
external files that may be stored on different locations on the computer.
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Exporting Images
From the menu bar, select File > Export Image.

An Export Image Dialog box will appear. A thumbnail window shows the current
selected frame.

File Information
Folder
Allows you to save their file in the default Documents folder, specify your own folder
location, or use Browse to select another folder of your preference.
Name and Type
You will be required to type in your preferred filename in the text field. You can
choose the default png image format, or select a different format from the dropdown
menu. CACANi supports png, jpg, bmp, tiff, tga and svg formats.
Start at
This allows you to assign a naming convention and appends a numeric value (1, 2, 3,
etc) to the end of each frame’s filename when they are exported from CACANi. This is
only configurable when All Frames or Selected Frames are selected in the Frames
property.
0 Padding
Adds zeros to the file name for image sequences so that the exported files will be
visually arranged in numeric order in the folder.
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Output Settings
Canvas View and Camera View
You can choose to export either the full canvas resolution or the camera resolution
from CACANi. In the comparison below, the canvas is 3000 x 3000 pixels while the
camera is 1414 x 1000 pixels.

Show Camera (Canvas View only)
When enabled, you can export the camera frame together with the drawings.

Show Peg Holes (Canvas View only)
When enabled, you can export the peg holes and animation information together
with the drawings.
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Presets
A set of resolution presets. Larger resolutions will result in sharper images, at the
expense of larger file sizes. By default, the Camera – Multi Frame preset is selected
when exporting with the Camera View option. This means that the animation
sequence is exported based on the camera resolution set in each frame. With this
preset, you can export an image sequence with a different resolution for each image.
You cannot alter the resolution when using this preset.

In contrast, the Camera – Single Frame preset sets a camera resolution for all the
frames in the sequence.

Finally, if you want to define your own resolution values, the menu will automatically
switch to the Custom Resolution preset.

Pixel Dimensions: Width and Height
You can manually specify the width and height of the exported image, in pixels. To
change the values in the Export Image window, you need to select the Single Frame
or Custom Resolution preset.
Print Size: Width, Height and DPI
You can also specify the physical width and height dimensions in centimeters or
inches. There is an additional option, the DPI or Dots per Inch. In CACANi, it is
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equivalent to PPI, or Pixels per Inch. This is useful when you have to print out the
images.

Keep Aspect Ratio
When enabled, the Width and Height is scaled proportionally whenever one of the
values is changed.

Preserve Pixels
When enabled, the Print Size Width, Height and DPI will be adjusted automatically to
fit the original pixel dimensions into the defined values. The Keep Aspect Ratio option
will also be enabled automatically. This is useful when you do not want the original
pixel dimensions to change.

Conversely, when the option is disabled, changing the DPI value will increase the pixel
dimensions of the image.
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Advanced Settings

Anti-Aliased Edges
When enabled, edges between different colors in the exported images will be
smoothed. A higher value will create a smoother result, but will also appear
increasingly blurred.
Render Stroke Width
Disabling this option will result in the exported image showing the centerlines,
without the stroke widths.
Render Strokes
Disabling this option will result in the exported image showing the painted regions
without the strokes.
Lines Only
Exports strokes only. Anti-aliasing is disabled in this mode.
Background
When enabled, all exported images will have an opaque background. You can further
define a background color.
Render Region Colors
When disabled, painted regions will not be exported.
Render Color Separation
When disabled, color separation lines will not be exported.
Trim Offsets
When enabled, frames that have no visible information are not exported. This is
applicable only when exporting a range of frames.
Open Containing Folder
CACANi will open the folder where the images are saved to after the exporting is
complete.
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Export Range:

Users can choose between:
Active Frame
Exporting only the active frame shown on the canvas as an image.
All Frames
Exporting all the frames in the animation sequence as an image sequence.
Selected Frames
Exporting a selected range of frames as an image sequence. The selection of frames
is done in the Cel Bank.
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Stroke Magnification
Strokes in the drawings can be thickened or thinned with the percentage slider during
the export stage, without affecting the original artwork.

Change All Stroke Colors
You can use this to specify a standard color for all strokes. This is
useful when there are multiple stroke colors in the drawings and
you need to view the artwork with those colors.

Switch Region Colors
You can use this to change a region color temporarily in the export
stage without affecting the original artwork.

Exporting Video
The options for exporting videos are mostly similar to those for exporting images.
From the menu bar, select File > Export Video.
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The differences are in the File Type and the Export Frames options. CACANi supports
avi, wmv, mp4 and mov video formats. Specifically, you can export videos with a
transparent background with the .mov format.
Enabling the Export Frames option allows you to export a selected range of frames.

FPS
Defines the playback speed of the exported video, in Frames per Second. A higher
value means the video will play much faster.

Duplicate
Allows you to increase the duration of the animation by duplicating each frame. This
is only configurable when exporting to the GIF format.
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Exporting to After Effects
After Effects is a digital visual effects, motion graphics, and compositing application
developed by Adobe Systems. If you own After Effects or work in a team project that
uses After Effects in the production pipeline, you can make use of this feature to
create an After Effects project with the layers and animation timings in CACANi still
intact.
From the menu bar, select File > Export to After Effects.

Since you will be exporting image sequences, the options are almost the same as the
Export Image window. The difference is that Export to After Effects will export
images from individual layers and create subfolders to store them.
Unlike the Export Image option, a folder named after the filename will be created.
You can change it to a different folder name.
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Then the options below allow you to decide how these images are exported and
organized.

In the example below, there are 2 cels with multiple layers in each of them.

Export All
Flattens all the layers when exporting, similar to how Export Image works. Folder
contains a single image sequence and the After Effects script.
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Export by Cels
Flattens layers into their individual cels. Each cel is exported as a subfolder.

Export by Layers
Each layer is exported as a subfolder.

After the folder and script are exported, you can now load the sequence into After
Effects by choosing (from within the After Effects application) File > Scripts > Run
Script, then choosing the jsx script file.
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END
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All characters used in the images of this manual are the property and copyright of their
respective owners. Special thanks to Eugene Babich (eugenebabichvr@gmail.com) and
Oldman Rabbit (sekainomaster@gmail.com) for the use of their artwork in the demonstration
of CACANi features.
Adobe, the Adobe logo, and After Effects are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.

All rights reserved. No part of this manual may be copied or reproduced in any form or by
any means without written permission from the publisher.
Copyright (c) 2014-2019 CACANi Private Limited. All Rights Reserved.
CACANi and the CACANi logo are either registered trademarks
or trademarks of CACANi Private Limited in Singapore and / or other countries.
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